
JULY 2016  |  MACWORLD.COM

SECRETS
APPLE TV
30 MUST-KNOW

INSIDE: HEADPHONE BUYERS GUIDE

All the tips and tricks you need to rule the living room





MacUser
The power of OS X’s menu bar 6

5 travel backpacks designed to carry 
your MacBook 12

Why can’t Safari sort bookmarks 
alphabetically? 18

MacUser Reviews 22

Hot Stuff 47

iOS Central
Essential gear for working with an 
iPad Pro 50

Mophie launches wireless
chargers 54

Hands-on with Vi, the fitness coach 
in your ear 58

iOS Central Reviews 62

What’s new at the App Store 72

iPad Cases 73

Working Mac
How to use one Mac in multiple 
rooms 102

5 ways to search Gmail that
everyone should know about 106

Asset management using 
Watchman Monitoring 110

How the Smart Connector could be 
key to an iPhone Pro 114

Play List
Apple simplifies navigation with 
iTunes 12.4 118

Keyboard shortcuts to better
navigate iTunes 12.4 124

How to trip out with the iTunes
visualize 128

Help Desk
Mac 911: How to export a Live
Photos movie into OS X 132

July 2016   CONTENTS
I N C O R P O R AT I N G  M AC U S E R

30 must-know secrets and shortcuts for 
your Apple TV  77

Headphone 
buyers guide  94

3



CCO & SVP, U.S. MEDIA AT IDG John Gallant

EDITOR IN CHIEF, CONSUMER BRANDS Jon Phillips

EXECUTIVE EDITOR Susie Ochs

DESIGN DIRECTOR Rob Schultz

Editorial
SENIOR EDITOR Roman Loyola 

ASSOCIATE MANAGING EDITOR Leah Yamshon

STAFF WRITERS Caitlin McGarry, Oscar Raymundo

SENIOR CONTRIBUTORS Adam C. Engst, Glenn Fleishman, Lex Friedman, Rob Griffiths,  

John Gruber, Jim Heid, Andy Ihnatko, Joe Kissell, Ted Landau, Rick LePage, Ben Long,  

Kirk McElhearn, John Moltz, John Siracusa, Derrick Story

COPY EDITOR Sue Voelkel

Design
DESIGNER Monica S. Lee

CONTRIBUTING PHOTOGRAPHER Peter Belanger

Advertising Sales
SALES MANAGER Duane Hampson 415/978-3133

Production
DIRECTOR, PRODUCTION Nancy Jonathans

INTERNATIONAL DATA GROUP CHAIRMAN OF THE BOARD  

Walter Boyd

IDG COMMUNICATIONS, INC. CEO  

Michael Friedenberg

MASTHEAD

44



HOW TO CONTACT MACWORLD SUBSCRIPTION SERVICES

Access your subscription account online—24 hours a day, 7 days a week—at www.macworld.com/customer_service or service.

macworld.com. You can use online subscription services to view your account status, change your address, pay your bill, renew 

your subscription, report a missing issue, get the answers to frequently asked questions, and much more. 

To start subscribing, visit subscribe.macworld.com. 

 U.S. MAIL Macworld Subscriptions Department 

  P.O. Box 37781, Boone, IA 50037-0781 

   (If you are writing about an existing account, please include your name and address at which you subscribe.)

 EMAIL  subhelp@macworld.com (Send your full name and the address at which you subscribe; do not send attachments.)

 FAX 515/432-6994

 PHONE 800/288-6848 from the U.S. and Canada; 515/243-3273 from all other locations 

The one-year (12-issue) subscription rate is $34.97; the two-year rate, $59.97; and the three-year rate, $79.97. Checks must 

be made payable in U.S. currency to Macworld. Please allow 3 to 6 weeks for changes to be made to an existing subscription.

MACWORLD EDITORIAL

The editors of Macworld welcome your tips, compliments, and complaints. Some stories and reviews from past issues can 

be located at www.macworld.com. We are unfortunately unable to look up stories from past issues; recommend products; or 

diagnose your Mac problems by phone, email, or fax. You can contact Apple toll-free, at 800/538-9696, or visit the company’s 

website, at www.apple.com. 

HOW TO CONTACT MACWORLD STAFF

Our offices are located at 501 Second Street, 6th Floor, San Francisco, CA 94107; phone, 415/243-0505; fax, 415/243-3545. 

Macworld staff can be reached by email at firstinitiallastname@macworld.com.

BACK ISSUES OF MACWORLD

Starting with the March 2003 Macworld, back issues can be downloaded in digital format, from www.zinio.com ($6.99; Mac OS 

X 10.1 or later required).  

REPRINTS AND PERMISSIONS

You must have permission before reproducing any material from Macworld. Send email to permissions@macworld.com; 

please include a phone number. 

MAILING LISTS

We periodically make lists of our customers available to mailers of goods and services that may interest you. If you do not wish to 

receive such mailings, write to us at Macworld, P.O. Box 37781, Boone, IA 50037-0781, or email us at subhelp@macworld.com.

PUBLICATION INFORMATION

July 2016, Volume 33, Issue 7 
Macworld is a publication of IDG Consumer & SMB, Inc., and International Data Group, Inc. Macworld is an independent 

journal not affiliated with Apple, Inc. Copyright © 2016, IDG Consumer & SMB, Inc. All rights reserved. Create, Playlist, 
Mac User, Macworld, and the Macworld logo are registered trademarks of International Data Group, Inc., and used under 

license by IDG Consumer & SMB, Inc. Apple, the Apple logo, Mac, and Macintosh are registered trademarks of Apple, Inc. 

55



MACUSER News and Analysis About 
Macs, OS X, and AppleMACUSER News and Analysis About 
Macs, OS X, and Apple

BY JASON SNELL

The power of OS X’s menu bar
It’s always there and it’s often overlooked, but the menu bar is a very useful part of the 

Mac operating system.
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The menu bar at the top of your computer screen has 

been with the Mac since the beginning. It’s one of the 

defining characteristics of the Mac, one that even Micro-

soft didn’t dare duplicate—in Windows, the menu bars 

go on the top of windows, not at the top of the screen. The Mac 

menu bar is a constant, a north star.

Except…things have been getting a 
little weird lately. Last year, Apple 
added an Automatically Hide And 
Show The Menu Bar feature to the 
General pane of System Preferences. 
When that preference is selected—or 
when you’re in full-screen mode—the 
menu bar appears only when you 
move your mouse to the top of the 
screen. It feels spectacularly wrong 
to me, but then, I’ve been using a 
Mac since George Bush was Presi-
dent. (The first one.)

Apple also recently added a new 
Use Dark Menu Bar And Dock mode, 
which flips the normally black-on-
white menu bar into a design only 
Darth Vader could love: white text on 
a black background. It’s not my cup 
of tea, and flipping that setting 
doesn’t change the style of any of 
the other black-on-white windows on 
my Mac’s screen, but if you like it, 
more power to you.

Even as someone who has com-
mitted plenty of keyboard shortcuts 
to memory, I find the menu bar 
incredibly valuable. And while it’s 
almost always in the faces of every 

Mac user, it’s too often ignored. The 
menu bar, like the Utilities folder (go.
macworld.com/utilitiesfolder), is a 
place that makes you a more efficient 
and informed Mac user.

THE MENUS THEMSELVES
Another uniquely Mac touch that has 
been with us since 1984 is the Apple 
logo in the top left corner of the 
screen. Back in the classic Mac OS 
days, this was originally the home for 

THE APPLE MENU in  
OS X El Capitan.
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tiny apps called Desk 
Accessories, and 
System 7 transformed it 
into a menu you could 
customize by dropping 
any item in the Apple 
Menu Items folder 
inside the System 
Folder. When OS X 
arrived, Apple almost 
eliminated the Apple 
menu in the OS X 
Public Beta, but 
ultimately shipped OS 
X 10.0 with more or less 
the same version of the 
Apple menu today.

Today’s Apple menu is a repository 
for all the stuff that Apple wants to 
give you quick access to, but that 
isn’t specifically related to the 
frontmost application. It gives you 
quick access to the System Prefer-
ences and App Store apps, a list of 
recently opened apps and docu-
ments in a submenu, and access to 
the Force Quit window. But perhaps 
most important is its integration of all 
the system power features which 
lived under the Special menu in the 
old days of Mac OS: Sleep, Restart, 
and Shut Down.

As with so many things involving 
the menu bar, holding down the 
Option key will reveal a bunch of 
alternate options. If you want to 
restart or shut down without being 

asked if you’re sure, hold down the 
Option key while selecting those 
items. If you’re trying to launch the 
System Information app without 
seeing the About This Mac window, 
the same method will get you there.

Next to the Apple menu is the 
Application menu, though it’s not 
labeled as such—this is the menu 
that displays the name of whatever 
the frontmost application is. Most of 
the menu items here are controlled 
by the application itself, but there are 
a few interesting window-manage-
ment tools here, allowing you to hide 
the current app, hide all apps except 
the current app, or show everything 
that was previously hidden.

More notable is that this is where 
the Services submenu lives. If you 

OS X MENU BAR

THE HELP MENU has a 
search function that 
can be used to find a 
particular command.
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create scripts using Apple’s included 
Automator utility, this is where they 
appear. The Services menu is divided 
in two: workflows that are available 
anywhere, anytime, and workflows 
that are particular to the app you’re 
currently using.

At the far end of an application’s 
menus is the Help menu, and if you 
fancy yourself a power user, you may 
have never used this menu. The Help 
menu is usually a place to view 
documentation, open web resources, 
or report a bug. But I use the help 
menu all the time, because of the 
powerful search function built into it. 
From the top of the Help 
menu, you can search the 
contents of every menu of the 
currently open app. When I’m 
using a complicated app like 
Numbers or BBEdit or Logic 
Pro, sometimes I can’t remem-
ber where to find a particular 
command. And I don’t need to 
know: I just type a word from 
the menu item and move my 
mouse over the right result. 
That menu item will activate 
and a big arrow will point right 
at it. You know, for education. 
You can also just click on the 
result to activate that com-
mand as if you had known 
where it was all along.

OTHER ITEMS IN THE  
MENU BAR
At the far right of the screen are a 
collection of icons supplied by Apple 
that give you quick access to infor-
mation and other features of your 
Mac. Exactly which items you see will 
depend on what kind of Mac you’re 
using (if it’s a laptop, you’ll see the 
battery menu-bar item) and how it’s 
configured.

Many, but not all, of these items 
can be reordered by holding down 
the Command key and clicking and 
dragging the icons in question. If you 
don’t want to see one of them 

SOUND OPTIONS FROM 
the menu bar.
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anymore, you can hold down Com-
mand and drag the icon out of the 
menu bar entirely. (Alas, the Spotlight 
and Notification Center icons at the 
far right of the menu bar are impervi-
ous to this sort of trickery.)

It’s obvious how to use these 
menu-bar items—you either look at 
them to garner information (like how 
much battery you have left, or what 
time it is) or you click on them to 
reveal a menu with more information 
or commands. But if you hold down 
the Option key before you click on a 
menu-bar icon, you may discover 
that some seemingly simplistic items 
have unexpected depths.

Take the Sound menu-bar item, 
for example. It couldn’t be simpler—
it’s just a volume slider. But if you 
Option-click on it, you’ll discover 
that you can quickly set new system 
input and output devices. Hold 
down the Option key and click on 
the Wi-Fi item, and you’ll get 
detailed information about your 
network interface, the status of the 
Wi-Fi base station you’re connected 
to, and extended information about 
any of the other Wi-Fi sources your 
Mac can see. (To do that, just move 

your cursor over one of the other 
sources and wait a second for the 
pop-up message to appear.)

ITEMS NOT FROM APPLE
If you’ve installed apps beyond what 
Apple provides, you may discover 
that some of them add icons to the 
menu bar as well. Dropbox lives in 
my menu bar and provides feedback 
when it’s syncing files, and I can click 
on it to quickly see what’s been 
added to my Dropbox recently. 
Online backup tools generally put a 
status item in the menu bar, provid-
ing quick access to your backup 
tools.

In addition to Dropbox, three of 
the other items I’ve come to rely on 
in my menu bar are:

Fantastical 2 (go.macworld.com/
fantastical2osxrev), which lets 
me glance at my forthcoming 
schedule and quickly create new 
calendar events simply by 
typing.
TripMode (go.macworld.com/
tripmoderev), a utility that lets 
me control what apps get to 
send data over my network 
connection. I use this on my 

OS X MENU BAR

BARTENDER
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MacBook Air when I’m tethering 
to my iPhone, so it doesn’t 
destroy my data allowance with 
stuff like online backup, and on 
my iMac as a way to ensure that 
only certain apps are using data 
when I’m doing a podcast or 
video conference.
BitBar (getbitbar.com), a free app 
that lets you put just about 
anything you want into the menu 
bar. I use it to display the current 
temperature from my backyard 
weather station, but you can 
script it to do just about any-
thing, or just download one of 
the many pre-built plug-ins for it.

ONE ITEM TO RULE THEM ALL
Finally, I have to heartily endorse the 
$15 utility Bartender (go.macworld.
com/bartenderrev), which gives you 
unprecedented control over your 
menu bar. Bartender lets you hide 
menu-bar items, show others, and 
relegate others (even Spotlight and 
Notification Center!) to a submenu, 
allowing you to de-clutter the menu 
bar.

I love the control that Bartender 
gives me over my menu bar. Just as 
the menu bar is one of the defining 
features of the Mac, so is personal-
ization. There are many menu bars 
out there, but this one is mine. ■



5 travel backpacks designed 
to carry your MacBook
It’s the start of summer travel season, and you don’t have to leave your laptop behind.

BY OSCAR RAYMUNDO

MACUSER
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In April, Apple updated the MacBook, making its already-

ultraportable laptop faster and giving it a longer-lasting 

battery. These improvements certainly made the MacBook 

even more ideal for travelers and people who are always on 

the go. Still sporting just one USB-C port, the new MacBook was 

built for a truly wireless world, according to Apple, so you won’t 

be bogged down by superfluous wiring.

With that travel-friendly mindset, we 
went on the hunt for the perfect 
backpack for taking your MacBook 
with you on all your summer adven-
tures. Some of these backpacks are 
big enough to fit even a 17-inch 
MacBook Pro, but small enough to 
still be considered a carry-on 
should you happen to be boarding 
a plane to a far-off destination. 
Here are five of our favorite back-
packs for bringing your MacBook 
along for the ride.

STANDARD LUGGAGE CO.’S 
CARRY-ON BACKPACK
This travel backpack by Standard 
Luggage Company (standardlug 
gage.com) was intended for all types 
of travel, whether a weekend 
getaway or some serious 
backpacking. You can tuck away the 
backpack straps and turn it into a 
duffel bag by holding it from the side 
handle, or add the shoulder strap 
and carry it like a messenger bag. 
The Standard Luggage (go.macworld.

STANDARD LUGGAGE 
CO.’S Carry-On 
Backpack
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com/stdluggagebackpack) backpack 
has a clamshell design, so you can 
open it and lay it out flat when you’re 
packing. In addition, it comes with a 
separate pocket for storing a 15-inch 
MacBook Pro. The main compartment 
can be expanded, too, if you happen 
to buy more stuff during your travels. 
This all-in-one bag retails for $179.

JUST PORTER SABLE 
RUCKSACK BACKPACK
Just Porter ( justporter.org) spent two 
years designing the Sable Rucksack 
(go.macworld.com/justportersab-
lerucksack), a waterproof, roll-top 
backpack which uses a custom 

thermoplastic polyurethane fabric to 
keep your things dry. And you know 
how you have to take out your laptop 
every time you go through airport 
screening? The Sable backpack has 
a padded laptop compartment with 
its own separate side-access, so you 
don’t have to dig for your MacBook. It 
also has quick-release magnetic 
buckles on the front, just in case you 
do need to get to the main compart-
ment in a hurry. The Sable Rucksack 
Backpack is available in gray, black, 
and olive for $199 from the Just 
Porter website or from Amazon for 
$200 (go.macworld.com/justporters-
ablerucksackamz). The company also 

TRAVEL BACKPACKSMACUSER

JUST PORTER Sable 
Rucksack Backpack, 
in gray
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has instituted a charity program so 
that for every backpack sold, they 
send a backpack full of school 
supplies to a kid in need.

NORTH ST. CLINTON 
BACKPACK
Another roll-top backpack, this one by 
Portland-based North St. Bags (northst-
bags.com), the Clinton back-
pack is handmade with only 
heavy-duty materials, including 
vented foam and fluorescent 
lining so you can easily spot all 
your stuff. The Clinton back-
pack is also perfect for people 
who are prone to back pain 
caused from carrying heavy 
backpacks. The shoulder 
straps were vetted by a 
physical therapist, so the 
backpack won’t destroy your 
back during long trips. You can 
also customize the inside of 
the backpack to attach more 
pockets onto Velcro rows for 
better organizing your lug-
gage. In addition, you can 
purchase external upgrades 
like a waist belt and an extra 
sleeve pocket. The 34-liter 
Clinton (go.macworld.com/
northstbagsclinton) backpack 
is $199, and the 20-liter model 
is $169 directly from North St. 
Bags.

INCASE EO TRAVEL 
BACKPACK
Incase (incase.com) is known for 
making stylish, top-notch accesso-
ries for all our Apple gear, so it’s no 
surprise that their travel backpack is 
also worth a serious look. The 
Incase EO Travel Backpack stores 
up to a 17-inch MacBook Pro in a 

NORTH ST. 
CLINTON 
BACKPACK

INCASE  
EO TRAVEL 
BACKPACK
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separate sleeve so you can get to it 
quickly without having to shuffle all 
your other stuff around. And it can fit 
a lot of stuff, as the main compart-
ment expands by 35 percent. You 
can get the EO Travel Backpack (go.
macworld.com/eotravelbackpack) in 
black for $180 or in heather gray for 
$220 on the Incase website. The 
black version is also available on 
Amazon for $122.24 and the heather 
gray is currently selling for $146.60.

AER DUFFEL PACK
Is it a duffel bag? Is it a backpack? It’s a 
Duffel Pack. San Francisco–based Aer 
(aersf.com) has designed a carry-on 

backpack that balances “smart func-
tionality with a clean, architectural 
aesthetic.” Unlike most backpacks, the 
Duffel Pack has a zipper down the 
middle of the main compartment. It’s 
also perfect for carrying both your 
“mobile office” and your workout gear 
with a ventilated shoe compartment 
and an expandable side pocket for 
storing your water bottle. For your tech 
gear, the Duffel Pack has a padded 
laptop compartment that fits up to a 
15-inch Macbook Pro. In addition, it 
also has a second padded pocket for 
your iPad. The Duffel Pack (aersf.com/
duffel-pack) is available on Aer’s 
website for $150. ■

TRAVEL BACKPACKSMACUSER

AER DUFFEL PACK
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in one app. WWF TOGETHER – the new free app 
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Remember when you first started using a web browser, 

how great it was to be able to save bookmarks? It  

was necessary back in the day, because you couldn’t 

remember all those URLs, and browsers didn’t  

auto-complete with addresses of your saved sites. They also 

didn’t suggest sites when you typed the name of a company  

or publication, so you needed to know the URL to get where 

you wanted.

But the more bookmarks you save, 
the harder it is to find what you’re 
looking for. Remember that site where 
you saw that really interesting article 
last month? You bookmarked it, and 
you remember the title, but if you look 
in your Safari bookmarks, you have to 
either scan the entire list, or search for 
it. Sure, you can sort bookmarks in 
folders, but who has the time to do 
that? And you’d only do that for the 
sites you visit very often.

Wouldn’t it be great if you could 
sort bookmarks alphabetically in 
Safari? There has never been a way 
to do this in Safari itself, but there is a 

way, one that’s been around for 
donkey’s years (go.macworld.com/
safarisort). The process is slightly 
different now.

Start by displaying your book-
marks in Safari (Bookmarks → Show 
Bookmarks). Click the Edit button at 
the bottom of the list.

Drag them all to a folder in the 
Finder; make sure you don’t select 
Bookmarks Menu, or you won’t be 
able to drag the bookmarks. Display 
that folder in List view (View → As 
List, in the Finder), and then click the 
Name header to sort the files by 
name.

EDIT YOUR SAFARI 
bookmarks to be able 
to drag them to the 
Finder.
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Next, move up a 
level in the Finder 
(press Command-up-
arrow), and drag that 
folder onto the book-
mark list in Safari. All 
your bookmarks will be 
added to the Book-
marks list, in that folder. 
You can delete the 
originals, then move the 
bookmarks out of the 
folder to the Book-
marks Menu, or to your 
Favorites. This is a lot 
of work for something 
that should be pretty 
simple.

You can do this easily 
in other browsers. For 
example, in Chrome, if 
you display your 
bookmarks and click 
the Organize menu, you 
can easily sort them 
alphabetically (Reorder 
By Title).

And Firefox gives 
you a plethora of sort 
options.

Fortunately, there’s 
an app for this: the free 
SafariSort (safarisort.
com), which can sort 
your bookmarks 
alphabetically, or in 

SORTING SAFARI BOOKMARKSMACUSER

TOP: Chrome lets you sort bookmarks 
alphabetically. BOTTOM: Firefox gives you lots of 
sort options for your bookmarks.



21

alphabetical order with all your 
bookmark folders on top of the list. 
It’s fast and simple, and if you like 
having bookmarks in order, you can 
run it regularly.

Wanting to sort bookmarks alpha-
betically doesn’t seem like an odd 
feature request; it’s actually a great 
way to cull duplicate bookmarks. In 
fact, Apple should allow Safari to 

display bookmarks in date order as 
well. If you add bookmarks to folders, 
you won’t see all your bookmarks  
by date, and having a full list in order 
can be a good way to find what 
you’re looking for.

No matter what, it would be nice  
if Safari offered some more ways  
to view bookmarks, as other brows-
ers do. ■

SAFARISORT is a 
simple app that sorts 
your bookmarks 
alphabetically.
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WITH VERSION 15, the FileMaker platform (filemaker.com) gets 
better, and it was pretty good already (go.macworld.com/filemaker-
14rev). But in terms of features, FileMaker 15 is an evolutionary rather 
than revolutionary release. Many existing users may not feel the 
need to rush to upgrade, and both new and current users may find 
the new licensing options a bit confusing.

BUSINESS SOFTWARE

FILEMAKER 15: EVOLUTIONARY 
RELEASE WITH A NEW LICENSING 
PROGRAM
BY WILLIAM PORTER

FILEMAKER PRO 15

mmmmh
AT A GLANCE

A powerful and widely used 
development platform gets 
better.
PRICE WHEN RATED

$329 individual license; $197 
upgrade; licensing for teams 
pricing available

FILEMAKER PRO 
ADVANCED 15

mmmmh
PRICE WHEN RATED

$2,664 perpetual license or 
$888 annual license for up to 
five users; licensing available 
for more users

FILEMAKER GO 15

mmmmh
PRICE WHEN RATED

Free
COMPANY

FileMaker

Reviews
MACUSER

MAC GEMS ARE APPS THAT OFFER 
STANDOUT UTILITY OR UNIQUE 
FEATURES AT A GREAT PRICE.

The Latest Mac Products 
Reviewed & Rated
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FILEMAKER GO
FileMaker Go (free; go.macworld.com/filemakergo) 
allows iPhone and iPad users to access and run 
FileMaker custom apps. Go only lets you use the app 
to access and manipulate its data; you can’t create a 
custom app in Go.

Want to build a relational database from scratch on 
your iPhone? Check out Airtable (go.macworld.com/
airtablerev). The difference between Airtable and 
FileMaker is instructive. Airtable is all about manag-
ing your data, and at that it does a brilliant job. By 
contrast, these days, FileMaker isn’t just a data-man-
agement tool; in fact, for a growing number of 
FileMaker developers who are using SQL back ends, 
FileMaker isn’t about managing the data at all. What 
really sets FileMaker apart is its strong toolset for 
creating rich user interfaces, or, in a word, apps.

FileMaker custom apps built for iOS are now even 
“appier.” With the iPhone 6s or later, Go 15 supports 
3D Touch. On the iPhone 5s and later, you can now 
log in to apps in FileMaker Go using Touch ID. As 
with other apps supporting Touch ID (such as a bank 
app), once you authenticate the old-fashioned way 
and permit iOS to store your credentials in Keychain, 
subsequent logins can be done via Touch ID, which is definitely easier 
and arguably more secure than typing a weak password on your iPhone. 
FileMaker Go 15 also supports app extensions that will make interaction 
with many other apps on your iOS device easier.

FileMaker Go 15’s other novelty is support for iBeacons (go.macworld.
com/filemakerproibeacons). A FileMaker 15 database can be designed 
to capture iBeacon signals from one or more beacons within a defined 
distance from the iPhone; the beacon location data can then be ana-
lyzed so users can be told what they’re close to.

I confess that I had never heard of iBeacons before, but despite being 
late to this party, I found it quite easy to set up a FileMaker Pro custom 
app to capture an iBeacon signal and convert it into useful info. If you’re 
using FileMaker technology, say, to manage inventory in a large ware-

FILEMAKER GO 15 allows you 
to save your login to the 
iOS Keychain, so next time 
you can get in using Touch 
ID instead of having to type 
your name and password.
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house, you may want to 
take advantage of this right 
away. And in six months or 
a year, you may find 
museums and public 
gardens using FileMaker 
databases capturing 
iBeacon signals to provide 
guided tours.

FILEMAKER FOR 
ANDROID?
A few versions ago File-
Maker introduced WebDi-
rect, a technology that 
allows users to access 
FileMaker databases in a 
web browser. Until now, 
WebDirect worked only on 
your desktop computer. 
And since FileMaker Go 
works only in iOS, that 
meant that there was no 
way to access a FileMaker 
database from an Android device. Well, on a smartphone or tablet 
running the latest version of either iOS or Android, you can now access 
a properly hosted FileMaker database without having to install FileMaker 
Go or anything else. Just open the database’s web location in the latest 
versions of Safari or Chrome and you’re in.

Making FileMaker apps available to Android users in Chrome is the 
most exciting thing about the FileMaker 15 release. Mobile browser 
support is available in iOS, too, but remember, FileMaker Go for iOS is a 
free download and provides a better experience.

FILEMAKER PRO AND PRO ADVANCED
The old lodestar of the FileMaker firmament, FileMaker Pro (go.mac-
world.com/filemakerpro), seems to be fading in brightness a bit, as more 

REVIEWS  |  FILEMAKER 15MACUSER

LOOK, MA, NO INSTALLATION! 
A FileMaker 15 custom app 
for attorneys, accessed in 
Google Chrome on an iPhone 
6 Plus. Works equally well 
in Chrome 48 on Android 
devices.
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attention is directed to Go and WebDirect. But apps 
run in Go or your browser still need to be built in Pro, 
or better, Pro Advanced, and the old programs do get 
a few tweaks that will matter only to developers: 
undo finally works in the script editor (yay!); layout 
inspectors have gotten a cosmetic refresh; etc. And 
of course, FileMaker Pro and FileMaker Pro 
Advanced 15 (go.macworld.com/filemakerproad-
vanced) provide necessary developer support for 
new features in Go like iBeacons, as well as providing 
the tools needed to optimize your apps or deploy-
ment in Go and/or WebDirect.

The one thing existing users of FileMaker might 
appreciate is the fact that the platform’s file format (.
fmp12) has not changed. Of course that just means 
you can easily open a FileMaker 12, 13, or 14 database 
in FileMaker Pro 15. It doesn’t mean you can go the 
other direction. In other words, to take advantage of 
new features in FileMaker 15, you’ll need to use 
FileMaker 15.

SERVER
FileMaker Pro still supports peer-to-peer sharing for a 
handful of other FileMaker licenses on the same LAN, 
but hosting your files in FileMaker is incomparably 
better in every way. Not only can your files be 
accessed by significantly more users when hosted by 
FileMaker Server (go.macworld.com/filemakerserver), 
they will also be more secure, access will be faster, 
backups will be easier, various processing tasks can 
be performed by Server, and finally, FileMaker Server 
is necessary if you wish to access your files remotely 
in FileMaker Go or WebDirect. Using a FileMaker 
database without Server to host it is like living in 
Dallas without a car: You can have a pretty good time, 
but you won’t be going anywhere.

Like FileMaker Pro and Pro Advanced, FileMaker 

THE LAYOUT INSPECTORS in FileMaker Pro 
Advanced 15 (top) and 14 (below).
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Server in version 15 gets few headlines and such improvements as it 
does get will be important mainly to developers and network admins: 
better logging, improved handling of SSL certificates, and a couple of 
performance enhancements.

NO ‘I’ IN TEAMS
On a less technical note, it looks like FileMaker Server is about to 
become the most important element of any 
FileMaker installation, not just because it 
serves databases to remote users, but also 
because it takes on an expanded role as the 
controller of FileMaker licensing.

At least for now, you’ll still be able to buy 
individual, perpetual licenses for FileMaker 
Pro and Server, priced at $329 for Pro, $549 
for Pro Advanced, and $1,044 for Server. 
Volume discounts with annual subscription 
pricing are also available, and buying in 
volume can bring the price per user per 
month of using FileMaker Pro down to $10 (not including Server) or even 
lower if you purchase larger bundles of licenses. These are described 
on FileMaker’s website as “legacy licensing” options.

But FileMaker 15 is introducing a new licensing model called “File-
Maker for Teams.” Basic cost per year is about the same as legacy 
volume discount subscriptions if you don’t need access via Go or 
WebDirect, and somewhat cheaper if you do. With FileMaker for Teams 
you’re licensing “user connections” rather than people (i.e., users) or 
apps on devices (i.e., connections), and the licensing will be handled not 
in the apps but in FileMaker Server. So FileMaker for Teams comes with 
a somewhat new flavor of FileMaker Pro–styled “FileMaker (for User 
Connections).” Yes, it’s awkward but at least it’s unlikely to contribute to 
acronym pollution. The functionality of FileMaker (for User Connections) 
is identical to that of the plain old FileMaker Pro, except that FileMaker 
(for User Connections) is activated only while it’s logged in to Server.

I am pretty sure FileMaker Incorporated regards this approach as 
simpler and in some ways it is. With the bad old approach, you had to 
calculate the average and maximum number of connections Server 
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AT LEAST FOR NOW, YOU’LL 
STILL BE ABLE TO BUY 
INDIVIDUAL, PERPETUAL 
LICENSES FOR FILEMAKER 
PRO AND SERVER, PRICED 
AT $329 FOR PRO, $549 
FOR PRO ADVANCED, AND 
$1,044 FOR SERVER.
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would be hit with at any one time during a typical day. With FileMaker for 
Teams, you just ask yourself how many users you have and you’re done. 
(Wouldn’t it be great if your cellular service provider simply asked you 
how many phone numbers you need?) The FileMaker for Teams licens-
ing model also more closely resembles the models used in the larger 
corporate database world, and in that respect, it may make TCO and ROI 
comparisons easier for decision makers.

Nevertheless, there’s going to be some pain involved in this transition. 
It’s unclear how legacy licensees will transition to FileMaker for Teams. 
Also unclear is how this will impact one of FileMaker’s core markets, 
namely, very small offices with fewer than five users 
and especially those who may have outsourced the 
hosting of their databases to one of the several 
excellent FileMaker hosting services available on 
the Internet.

BOTTOM LINE
The FileMaker 15 release will matter more to some 
groups of users than to others. If you’re a single 
user or a very small office just looking to manage 
your data, you might not need FileMaker at all: 
Airtable (go.macworld.com/airtablerev) might be a 
better fit. If you’ve been using FileMaker Pro 14 (or earlier) with old-fash-
ioned perpetual licenses, and if you’re happy with what you have now, 
then the case for upgrading to 15 is not compelling.

I’d recommend especially that small-office users currently hosting files 
through a service like FileMaker Hosting Pros or Point in Space delay 
upgrading until all the implications of the new licensing terms for File-
Maker Server become clear. But if you’re already on a subscription plan 
with FileMaker, and especially if you wish to take advantage of the 
improvements on mobile devices, I urge you to take advantage of your 
option to upgrade without delay. ■

IF YOU’RE A SINGLE 
USER OR A VERY SMALL 
OFFICE JUST LOOKING 
TO MANAGE YOUR 
DATA, YOU MIGHT NOT 
NEED FILEMAKER AT 
ALL: AIRTABLE MIGHT BE 
A BETTER FIT.
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IF YOU’VE BOUGHT a new Mac in recent years, chances are it 
arrived with flash storage in place of a traditional hard drive. In terms 
of reliability and rapid-fire boot times, flash storage is awesome, but 
it’s expensive. So to make it more affordable, you don’t get the 
capacity you see with hard drives.

There are a lot of ways to work around the built-in limited flash 
storage, but there’s another method for eking out a little more space: 
Purge duplicate files. Few of us bother doing it, because weeding out 
extra copies of photos, documents, and other media simply takes too 
much time and energy.

UTILITY SOFTWARE

GEMINI 2: FIRST LINE OF DEFENSE 
AGAINST DUPLICATE FILES ON 
YOUR MAC
BY J.R. BOOKWALTER

GEMINI 2

mmmm
AT A GLANCE

Gemini 2 identifies duplicate 
folders, pictures, applications, 
music files, documents, and 
videos on your Mac and helps 
free up space by eliminating 
them safely.
PROS

duplicates from similar 
matches

folders, or entire libraries  
(OS X Photos, iTunes)

CONS

out of place

intelligent

version
PRICE

$20
COMPANY

 

MACUSER
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SEEING DOUBLE
With Gemini 2 ($20; go.macworld.com/gemini2) there’s little reason to 
fear duplicates. It has a polished, intuitive user interface and the brains 
to differentiate copies from originals by testing them against nearly a 
dozen different parameters. It’s also much faster, especially compared to 
digging through thousands of files and folders the old-fashioned way.

The software’s front end is little more than a large plus button where 
you add or drop folders you want to examine. Click the green Scan For 

GEMINI 2 OFFERS 
a minimalist user 
interface for adding 
or dropping files 
and folders you 
want to examine for 
duplicates.

AFTER ADDING FILES or 
folders to Gemini 2, 
starting a scan requires 
little more than a click.
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Duplicates button, then sit back as the software builds a map of your 
folder(s) and identifies files believed to be copies, displaying an estimate 
of how much space can be reclaimed.

Assuming duplicates are found, a quick breakdown of the results will 
be displayed. The garish color graphs from the first version have been 
replaced by an eye-pleasing circular ring that displays the content type 
as you hover the mouse around it. Users can then review scan results, 
which expands the window to display content in a grid or list view, 
sorted as exact duplicates or similar files. Double-clicking a thumbnail 
allows users to visually compare files side-by-side with relevant data 
(size, last modification date, path, and dimensions), which works particu-
larly great with photos and videos.

There’s also a search field to further limit results to specific queries. 
Once your selections have been made, duplicate files can be removed 
by clicking a button in the bottom right corner. By default, files removed 
by Gemini 2 are first moved to the system Trash as a safeguard, but this 
behavior can be modified in Preferences → Removal; files can instead be 
moved to a specific folder of your choice or permanently deleted with a 
single click, should you prefer to live dangerously.

WORK SMARTER
In most cases, the summary window also offers a second option called 
Smart Cleanup, which purges anything automatically selected as an 
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FOLLOWING A SCAN, Gemini 2 
displays how much storage 
space you might be able 
to free up, along with a 
breakdown of content type.
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exact duplicate by Gemini 2. This option is faster for casual users, but it 
was also easy to trip up the software by copying and pasting the same 
PDF files into a folder several times, which incorrectly reported no 
duplicates found.

There are a few occasions where Smart Cleanup isn’t an option—pro-
cessing entire OS X Photos or iTunes music libraries, for example. In 
those cases, you’ll want to examine potential duplicates more carefully. 
However, the software offers yet another safety net, this time moving 
images or songs to a Gemini Duplicates album for your protection.

It’s important to clarify the distinction between potential and exact 
duplicates. For example, after scanning my entire OS X Photos library, 
Gemini 2 reported 4.12GB worth of potential duplicates, yet only 102.1MB 
qualified as exact duplicates worthy of deletion. In my tests, the software 
was exceptionally accurate detecting exact matches, but potential 
dupes often include similarly named music tracks or photos with similar 
poses and slight framing adjustments you may prefer to keep.

Overall, MacPaw has done a great job streamlining and tuning up 

GEMINI 2 USERS can review 
scan results using an 
intuitive window that 
separates exact duplicates 
from similar matches.
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Gemini 2, but they’ve added a 
needless diversion in the process. 
The application now unlocks 
game-style achievements that 
allow users to “rank” higher the 
more it’s used. Users can click the 
star icon in the upper right corner 
to see where they currently stand, 
or view hints on how to unlock 
additional achievements. Thank-
fully, there’s a preference setting to 
disable such in-app notifications, 
which I found more distracting than 
fun.

BOTTOM LINE
Gemini 2 improves on a utility that 
was already quite good, but adding 
game-style achievements turns out 
to be a dubious new “feature.” ■
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GAME-STYLE ACHIEVEMENTS are more of a distraction than a true new 
feature in Gemini 2.



OS X PHOTOS makes it super easy to create basic slideshows from 
still images, but such presentations tend to be fairly basic, with only 
rudimentary control over the end results. That’s why I’ve been a 
longtime fan of Boinx Software’s FotoMagico (boinx.com/fotomagico), 
which blends iLife-style simplicity with a robust set of tools for 
creating impressive, visually rich slideshows in up to 4K resolution. 
Whether it’s for a wedding, to enhance travel videos, or a visual 
scrapbook of family memories, FotoMagico gets the job done with 
style and grace.

That’s no less true with the recently released fifth edition, which 

GRAPHICS AND DESIGN

FOTOMAGICO 5: MORE IMPRESSIVE 
THAN PULLING RABBITS OUT OF A 
MAGIC HAT
BY J.R. BOOKWALTER

FOTOMAGICO 5.0.6

mmmmh
AT A GLANCE

FotoMagico 5 makes it easy to 
create gorgeous slideshows on 
the Mac, complete with 
photos, videos, music, and text 
using pre-built stories or 
ready-made story parts.
PROS

stories

placeholders

CONS

results

version

requires Pro version
PRICE

$50; Pro version, $100
COMPANY

boinx.com
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further streamlines an already great application, making it easier than 
ever to create slideshows from pre-built snippets and royalty-free music 
capable of going far beyond OS X Photos.

REUSE AND RECYCLE
After consolidating separate Home and Pro versions into a single package 
with version 4, FotoMagico 5 (boinx.com/fotomagico) shifts things into 
reverse, again splitting into two releases, one aimed at consumers, the 
other intended for professional photographers. This approach makes the 
$50 basic edition cheaper than ever, while the new Pro version remains at 
the $100 price established by the previous release; upgrades start at $50.

Both versions adopt a new, darker user interface (with the option to 
switch back to the classic look if you want) which really helps make images 
pop off the screen, as well as Animation Assistant, which automates the 
process of enhancing slideshows with motion. Rather than treating every 
photo exactly the same, this feature accounts for the proper aspect ratio of 
portrait or landscape images, as well as video content and text.

IT’S EASY TO build slideshows 
using FotoMagico 5’s 
Storyboard mode and rich 
palette of tools.
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FotoMagico 5 also introduces a feature called Snippets, a far more 
powerful way to build custom slideshows. Stories can be used to create 
complete, start-to-finish presentations using royalty-free music in a 
variety of themes like Sightseeing, Beach, or Zoo, each with pre-com-
posed placeholder shots the user swaps out for their own images.

Stories are only a starting point. You can add, rearrange, edit, or delete 
individual slides as needed. There are also a variety of other drag-and-
drop snippets for intros, titles, split-screens, effects, credits, and music, so 
even if you choose to build entire slideshows from scratch, FotoMagico 5 
helps automate the process without the cookie-cutter look and feel of a 
template. You can purchase additional snippets from the Boinx website, or 
create your own to reuse later in other projects.

ABRACADABRA!
As a result of forking back into two applications, a number of previous 
features are no longer part of the consumer version, notably timeline 

BOTH VERSIONS of FotoMagico 
5 include the ability to build 
slideshows using snippets, 
but only the Pro edition now 
works in timeline view.
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view, access to Lightroom or Aperture libraries, and the ability to export 
ProRes video files. But FotoMagico 5 Pro has several new tricks up its 
sleeve. Users can now incorporate placeholder text into presentations, 
such as EXIF metadata stored inside photos, slide numbers, or title and 
artist information from the currently playing music track.

Editing text in previous versions was rarely a pleasurable experience, 
but Boinx finally kicked the slow, inefficient OS X font panel to the curb, 
incorporating native formatting options directly into the Options sidebar. 
The company also answered the call when it comes to audio, introduc-
ing precise keyframe control over volume level—perfect for situations 
where automatic “ducking” of the music track can’t handle the job.

The new Audio Marker Assistant makes it easier to synchronize 
images against music. Control-click an audio track, select Audio Marker 
→ Assistant from the contextual menu, then adjust the periodic markers 
setting for automatic results, or you can add custom markers by press-
ing the M key in real time as the track plays back.

Unless your audio file includes beats per minute (BPM) info embed-

FOTOMAGICO 5 includes a 
number of export options, 
but only the Pro version can 
handle ProRes and custom 
video files.
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ded in the metadata (which the bundled Creative Commons songs do) 
or the track is popular enough to find this information on the Internet, 
this feature requires a fair amount of fiddling for best results. The 
assistant can’t analyze songs to help automate the process, although 
third-party software like beaTunes ($35; beatunes.com) can be used to 
detect and add BPM data to an entire iTunes library in a few clicks.

BOTTOM LINE
FotoMagico 5 is a dazzling new edition of an already fantastic, afford-
able slideshow solution for all Mac users, but the Pro version offers the 
most bang for the buck. ■

GOODBYE, OS X font panel. 
FotoMagico 5 now includes 
a faster way to format text 
without leaving the Options 
sidebar.
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GRAPHICS AND DESIGN

QUARKXPRESS 2016: NEW 
FEATURES HELP YOUR 
DOCUMENTS LOOK THEIR BEST
BY JAY J. NELSON

QUARKXPRESS 
2016

mmmmh
AT A GLANCE

QuarkXPress 2016’s new ability 
to convert objects and pages 
from other programs makes 
this version a vital upgrade for 
any user.
PROS

convert a wide range of 
documents to native 
QuarkXPress items

and easy

stable.
CONS

objects from other apps
PRICE

$849; education price, $89; 
non-profit price, $299; upgrade 

upgrade from QuarkXPress 
versions 3 to 10, $349
COMPANY

Quark

MACUSER

YOU HAVE TO HAND IT TO QUARK: every few versions it adds a 
major new capability that has never existed in any program before. 
With QuarkXPress 2016 (quark.com/products/quarkxpress), it’s added 
the ability to—cue drum roll, please—convert imported PDF, EPS, and 
Adobe Illustrator files to native editable QuarkXPress objects. You 
can even convert objects or entire pages from Adobe InDesign, 
Adobe Illustrator, Microsoft Office (including Word, Excel, and Power-
Point), CorelDraw, Affinity Designer, and other apps.

QuarkXPress 2016 has other innovative new features, many of 
them based on requests from users. QuarkXPress 2016 is also 
impressively fast and stable, and those upgrading will be delighted 
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that XTensions written for QuarkXPress 2015 also work with 
QuarkXPress 2016 (as long as the XTension doesn’t conflict with a  
new function). And unlike Adobe InDesign, QuarkXPress doesn’t  
require an ongoing subscription. Its perpetual license lets you use  
the program forever.

CONVERT PDF, EPS, 
OR ADOBE 
ILLUSTRATOR FILES 
TO NATIVE 
QUARKXPRESS 
OBJECTS
Surprisingly, it takes 
only a few seconds for 
QuarkXPress 2016 to 
convert every object in 
a PDF, EPS, or Adobe 
Illustrator file to a native 
QuarkXPress object. 
You don’t have to 
convert an entire 
document; if you import 
the file into a QuarkX-
Press picture box and 
crop it, only the area 
showing in the box will 
be converted. You also 
have the option of 
keeping the original 
picture box intact and 
converting a copy.

The importance of 
this capability cannot 
be overstated. Design-
ers often work with 
charts, graphs, and 
PowerPoint slides that 

A PRODUCT LABEL in Adobe Illustrator (top), converted to InDesign (center) and 
converted to QuarkXPress (bottom), with text objects selected. 
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almost never use the correct colors or fonts for a company’s brand. 
Conveniently, when these items are converted to native objects in 
QuarkXPress 2016, their colors are added to the Colors palette where 
they can be replaced all at once with your brand-approved colors. The 
text in these graphics is also converted to native QuarkXPress text, so 
you can easily format it to match the brand by using Style Sheets.

Speaking of text, when converting from these other formats, QuarkX-
Press does an amazing job of putting text that belongs together into one 
text box. In contrast, converting these files in Adobe Illustrator breaks 
the text into so many text objects that it’s almost impossible to edit them. 
(Many designers prefer to rebuild artwork from scratch rather than 
wrestle with this mess.)

After converting, vector graphics become native 
QuarkXPress objects and Adobe Illustrator paths 
become QuarkXPress paths with the exact same 
Beziér anchor points as in Illustrator. You can then 
use the Beziér (pen) tools in QuarkXPress to adjust 
them.

Here’s one timesaving use for these conversions: 
Publications almost always receive advertisements 
in PDF format, and once they’re converted to native 
QuarkXPress objects, the publication can update 
prices, dates, and colors inside the ad. That’s never 
been possible in a page-layout program before.

Also, publishers who import charts or maps now 
have a unique trick available to them. After convert-
ing to native QuarkXPress objects, the chart or map 
can be resized without changing the size of the text 
within it. (The Scale feature in QuarkXPress lets you 
choose which attributes to scale.)

To test QuarkXPress’s ability to convert a wide variety of files, I 
scavenged up the most complex files I could find, dating back to the 
early 1990s. Unbelievably, every EPS, PDF, and AI file converted per-
fectly and within seconds. However, any fonts used in these files need to 
be active on your computer, or else QuarkXPress displays its “missing 
font” dialog. (If you subsequently activate those fonts, the document 
displays normally.) Unfortunately, sometimes when converting PDF files 
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PUBLICATIONS ALMOST 
ALWAYS RECEIVE 
ADVERTISEMENTS 
IN PDF FORMAT, 
AND ONCE THEY’RE 
CONVERTED TO 
NATIVE QUARKXPRESS 
OBJECTS, THE 
PUBLICATION CAN 
UPDATE PRICES, 
DATES, AND COLORS 
INSIDE THE AD. THAT’S 
NEVER BEEN POSSIBLE 
IN A PAGE-LAYOUT 
PROGRAM BEFORE.
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each line of text ends 
with a hard return that 
may need to be 
removed before editing 
the text. That’s a 
limitation of how the 
PDF was originally 
generated.

CONVERT INDESIGN, 
MICROSOFT OFFICE, 
AND OTHER 
OBJECTS TO NATIVE 
QUARKXPRESS 
OBJECTS
The magical conver-
sions continue: You can 
copy objects from many 
other applications—
including Adobe 
InDesign, Illustrator, 
CorelDraw, Affinity 
Designer, Word, Excel, 
PowerPoint, and Apple 
Pages—and paste them 
into QuarkXPress as 
native QuarkXPress 
objects. And yes, you 
can successfully 
convert an entire 
InDesign page to 
QuarkXPress.

In my testing, every object or group of objects I copied from Adobe 
InDesign and Illustrator, and from Microsoft Word and Excel, converted 
to native QuarkXPress items flawlessly. PowerPoint slides converted 
well, but each line of text became its own box. Graphics from Apple 
Pages converted as expected, but text lost its formatting. To maintain 

A LABEL IN Adobe Illustrator (top), converted to InDesign (center) and converted to 
QuarkXPress (bottom). The difference in display quality is obvious. 
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the formatting, Quark recommends exporting the document from Pages 
as a PDF file and then converting the PDF file in QuarkXPress.

This ability to convert objects from other applications opens a whole 
new world of graphic possibilities. For the first time, you can use the 
Smart Art tools in Microsoft Office applications to create flowcharts and 
then fine-tune them in QuarkXPress. Same for charts and graphs in 
Illustrator, CorelDraw, or Microsoft Office. This could fundamentally 
change the relationship between corporate chart producers and page-
layout artists.

TEXT BLOCK CONVERSIONS ARE MORE  
USABLE IN QUARKXPRESS
While InDesign can convert a native Adobe Illustrator file into native 
InDesign objects (it can’t convert PDF or EPS), the resulting text frames 
are broken up and difficult to use. In contrast, QuarkXPress 2016 con-
verts the objects exactly as they were in Illustrator. 

ON-SCREEN DISPLAY DRAMATICALLY BETTER THAN ADOBE’S
In QuarkXPress 10, Quark replaced the on-screen rendering engine and 
the results are far more accurate than what you see in Adobe InDesign, 
Illustrator, or other Adobe apps. The difference is very clear now that the 
user can convert those documents into QuarkXPress. 

INSTANT EXPORT TO HTML5
HTML5 is the language of modern websites, ebooks, and some mobile 
apps. QuarkXPress 2016 can export anything you create (or convert) to 
an identical version as an HTML5 publication. This means you can 
export a reflowable ePub, a fixed-layout ePub file, or a web version of 
your document with one or two clicks.

You can add interactivity to any page item using the HTML5 palette, 
and QuarkXPress 2016 will export a fully functioning version by generat-
ing a combination of HTML5, CSS, and JavaScript. Besides allowing you 
to import and control an audio or video file, you can make buttons that 
perform various actions (go to another location, a webpage, hide and 
show objects, and so forth), create hotspots and pop-ups, flip pages, 
rotate and slide items on the page, zoom into pictures, create multi-
image slideshows and carousels, send email, use HTML5 widgets, 
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geolocate the user, or display the live content of a webpage.
Perhaps most interestingly for publishers, you can create a Scroll 

Zone that displays only a portion of the content of a text box, but then 
the user can use scroll bars attached to it to view the rest of the story. 
And for the first time, HTML5 now allows almost every typographic trick 
in QuarkXPress, including runaround text, justified and hyphenated text, 
vertically justified text, text indents (indent here and discretionary 
returns), text color opacity, text aligned with baseline, outline, and 
multi-level bullets and numbering (in Fixed Layout 
ePubs), custom kerning and tracking, tabs and tab 
stops, fractions and prices, and native “pop-up” 
footnotes (in Fixed Layout ePubs).

It’s important to remember that QuarkXPress offers 
two kinds of HTML5 export formats: EPUB and HTML5 
Publication. EPUB is for documents intended to be 
read on eBook readers such as the Kindle or iBooks 
on your Mac or iOS device, while HTML5 Publications 
are read inside a browser. HTML5 Publication is best 
used for brochures, interactive content marketing 
pieces, catalogs, and perhaps magazines. If you add 
interactivity, they can feel like an app, but you have to 
host them on your own web server.

(In order to include interactivity in an HTML5 publica-
tion, Quark includes a web app in the exported pack-
age. This means that your HTML5 publication must be 
hosted on a web server to be seen by others. Fortu-
nately, your Mac includes a built-in web server you can 
employ to instantly share the publication over the 
Internet. QuarkXPress also has a preview button that 
exports and opens your publication in your computer’s 
default browser so you can test your publication’s 
functionality before sharing it with others.)

OPENTYPE STYLISTIC SETS
Many advanced OpenType fonts contain Stylistic Sets, 
which create harmonious combinations of letterforms 
chosen by the font designer. This comes in handy when 

THE HTML5 PALETTE in 
QuarkXPress 2016 lets you 
add interactive behaviors 
to page items.
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there are several alternate 
versions of a character, and 
you simply want the nicest 
choice for your text. (For more 
on this topic, see Lesa Snider’s 
article “How to access advanced OpenType features in a variety of 
apps”; go.macworld.com/opentypeinapps.)

QuarkXPress now gives you access to Stylistic Sets in the 
Measurements palette. Click the green O to see them. (First, 
choose an advanced OpenType font, which often has “Pro” in its 
name.) OpenType options in QuarkXPress are far more conve-
nient to use than those in Adobe’s products, which are squirreled 
away in a submenu of a panel’s tiny fly-out (side) menu.

COLOR PICKER AND MULTI-COLOR BLENDS
Formerly an XTension, the new Color Picker lets you click on any 
item (including imported pictures) to add new color swatches to your 
layout. Logically, it’s located at the bottom of the Colors palette.

Blends (gradients) in QuarkXPress 2016 can now include more than two 
colors. Each color can have a different level of opacity (transparency) and 
tint, and you can adjust them with sliders or by typing in values.

CLEAN CACHES AND DELETE PREFS FILE
Because Quark has historically followed the font management rules of 
the operating system while its competitors haven’t, sometimes the 
information it stores about fonts becomes confused. Since version 10 
they’ve provided a QuarkCacheCleaner app to delete the font and 
picture cache files used by QuarkXPress. Responding to user requests 
for troubleshooting, this utility now has an option to delete the QuarkX-
Press Preferences file as well. (You’ll find it in the Tools folder inside the 
QuarkXPress 2016 folder.)

OTHER USER-REQUESTED IMPROVEMENTS
A common complaint from designers is that the items in palettes and 
panels are too small to see, especially on smaller screens with high 
resolutions. Quark has begun to address this issue with an optional 50 
percent larger size for the icons and text in the Measurements palette, 

REVIEWS  |  QUARKXPRESS 2016MACUSER

THE OPENTYPE 
options in 
QuarkXPress 
are one click 
away in the 
Measurements 
palette.
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which is by far the most used palette in QuarkXPress.
You can now pinch, zoom and rotate items using gestures on your 

Mac’s touchpad.
Quark finally added a Fit Box to Text feature, so that if your text is 

shorter than the box, or if it overflows the box, the box will resize to fit 
the text. This feature even balances text in boxes that have multiple 
columns of text.

As you drag an item, indicators conveniently appear to show you its 
spacing in relationship to other items. This makes it easy to align and 
uniformly space items. In QuarkXPress 2016, guides now appear that 
show when the edges and centers of text columns and gutters align with 
other items, even in multi-column text boxes.

The Find/Change feature now remembers your 
most recent searches and allows you to search 
for nonbreaking spaces and characters.

Content variables can now wrap onto multiple 
lines just like regular text, which is useful for 
longer headers and for created/modified/printed 
slugs.

Print experts will appreciate support for ICCv4 
color profiles.

STILL MISSING IN ACTION
Quark dropped out of the features arms race 
with InDesign many years ago, instead focusing 
on providing the features most requested by its 
users. For example, QuarkXPress still lacks a 
Links palette. To determine the name and 
location of an imported graphic, you still need to 
open the Usage dialog. (Granted, you can select 
one or more picture boxes on a page first and when you open the 
Usage dialog those pictures are highlighted in it for you. Conversely, 
when you click on an item in the Usage dialog you can click the Show 
button to be taken to that item in the QuarkXPress document.)

Another feature from InDesign I’d like to see in QuarkXPress is 
multi-place: the ability to load the cursor with multiple graphics files and 
then click to import each one. In light of QuarkXPress 2016’s new ability 

COLOR BLENDS CAN now 
include multiple colors, 
each with varying levels 
of tint and opacity.
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to convert PDF files to native objects, being able to 
quickly import each page of the PDF could save 
time.

BOTTOM LINE
QuarkXPress 2016’s new ability to convert objects 
and pages from other programs makes this version a 
vital upgrade for any user. The ability to export 
HTML5-based publications with interactivity will 
make modern publishers happy, and the dozen or so 
smaller improvements add efficiency to an already 
fast and efficient program. ■
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FOR THE FIRST TIME, 
YOU CAN USE THE 
SMART ART TOOLS IN 
MICROSOFT OFFICE 
APPLICATIONS TO 
CREATE FLOWCHARTS 
AND THEN FINE-TUNE 
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STANDARD LUGGAGE CO.’S 
CARRY-ON BACKPACK
The $179 Carry-On Backpack by Standard 

Luggage Company (standardluggage.com)

was intended for all types of travel, whether 

you’re going on a weekend getaway or some 

serious backpacking. You can tuck away the 

backpack straps and turn it into a duffel bag by 

holding it from the side handle, or add the 

shoulder strap and carry it like a messenger 

bag. The Standard Luggage backpack has a 

clamshell design, so you can open it and lay it 

out flat when you’re packing. In addition, it 

comes with a separate pocket for storing a 

15-inch MacBook Pro. The main compartment  

can be expanded, too, if you happen to buy 

more stuff during your travels. —OSCAR RAYMUNDO



MACUSER

HEX SOLO WALLET CASE  
FOR THE iPHONE 6/6S
One of our favorite iPhone 6/6s wallet cases is Hex’s $40 

Solo Wallet (shophex.com). It’s not a traditional folio design, 

but we ended up preferring its placement of two handy 

card slots right in the back. Sliding out your credit cards 

when you walk up to a checkout counter is a snap—but the 

case is also engineered in such a way that whatever you 

secure in the slots doesn’t fall out, even if your iPhone ends 

upside down. The Solo Wallet also comes with the option of 

a neat “stingray” texture that offers an excellent grip, and 

combines easy installation with a unibody design that 

protects your handset without requiring a cover. That’s a 

real time saver when you need to answer a call or check 

your screen for notifications, and also very handy for use 

with car mounts, since you won’t need to fold back a front 

flap. —MARCO TABINI

Hot Stuff
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ADONIT PIXEL
Adonit’s new Bluetooth stylus, the $80 Pixel (adonit.net), is more accurate and 

responsive than its older products, but still no match for the Apple Pencil. 

However, the Pixel’s selling point is compatibility. Apple Pencil works with just the 

12.9-inch and 9.7-inch iPad Pro models, while the Pixel is compatible with the 

iPhone 5 line, 6/6s, 6 Plus/6s Plus, third- and fourth-gen iPads, iPad minis from 

1–4, both iPad Air models, and the 12.9-inch iPad Pro. The Pixel doesn’t work 

with the little Pro just yet. What’s more is that the Pixel is an affordable pen that 

packs a ton of features—pressure sensitivity, palm rejection, two shortcut 

buttons, and a 1.9mm Pixelpoint tip to name a few—into a sleek, easy-to-use 

package. Its improved tip is a big upgrade from the older Adonit 

devices, thanks to tip drag. I also loved the grip sensor, 

which meant I could just pick up the pen and start writing. 

For non-Pro users, the Pixel is a no-brainer. —CAITLIN MCGARRY
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Essential gear for working  
with an iPad Pro
Who cares if it’s a laptop replacement as long as you’re getting your 

work done? These accessories can help.

BY JASON CIPRIANI
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The last time we took a look at extra tools and accessories 

to help you get more work done on an iPad, the iPad Pro 

was nothing more than a glass slab of rumors.

As we now know, the iPad Pro is very 
real. Whether you’re thinking of 
picking up an iPad Pro, or already 
have one and want to get more out 
of the tablet, here are some acces-
sories I’ve found that make working 
on the iPad Pro a breeze.

APPLE’S SMART KEYBOARD
There are several Bluetooth-enabled 
keyboards available for both sizes of 
the iPad Pro, but they’re often bulky 
and require charging. It only makes 
sense to use a keyboard that takes 

advantage of the iPad Pro’s Smart 
Connector. Apple’s Smart Connector 
provides power to the keyboard, and 
provides two-way communication 
between the keyboard and iPad Pro.

Unfortunately, right now there’s 
only two options for the 12.9-inch 
iPad Pro: Logitech Create (go.mac 
world.com/logitechcreaterev) and 
Apple’s Smart Keyboard. For the 
9.7-inch iPad Pro, so far only Apple’s 
keyboard uses the Smart Connector.

I’ve tested Logitech’s Create 
keyboard and found it to get the job 

THE SMART KEYBOARD 
never needs 
charging and pairs 
automatically, 
thanks to the Smart 
Connector.
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done, however it was bulky and 
difficult to take the iPad Pro out of 
when needed.

Apple’s Smart Keyboard is cur-
rently the best Smart Connector–
enabled typing accessory for either 
iPad Pro model. The 12.9-inch model 
(go.macworld.com/ipadpro129) 
retails for $169, while the 9.7-inch 
model (go.macworld.com/ipadpro97) 
can be had for $149.

ADAPTERS
With only one port on the iPad Pro, 
it’s only natural you’ll need to 
purchase an adapter or two.

When it comes to official adapters 
from Apple, you can choose 
between the $39 Lightning to USB 3 
Camera Adapter (go.macworld.com/
lightningusb3), the $29 Lightning to 
USB Camera Adapter (go.mac world.
com/lighningusb camera), or the $29 
Lightning to SD Card Camera Reader 
(go.macworld.com/lightningsdcard).

With that said, if you own the 
12.9-inch iPad Pro you should 
limit your options to the SD 
Card Reader and the 
Lighting to USB 3 adapter. 
Why? Because those two 
adapters offer USB 3.0 
support, and only the larger 

tablet is equipped with the same 
technology. A USB 3.0 connection 
will decrease the amount of time you 
spend waiting for photos and videos 
to transfer from your camera or card 
to your iPad Pro.

I currently carry the Lighting to 
USB 3 adapter. Not only can I 
connect USB devices to my iPad Pro 
using this adapter, I can continue to 
charge the iPad Pro through the 
Lightning port on the adapter. Plus, 
you can use it to connect USB 
microphones, keyboards, and 
Ethernet adapters to your iPad.

FASTER CHARGING
You can cut the amount of time it 
takes to fully charge the 12.9-inch 
iPad Pro in half when using Apple’s 
29W power adapter (go.macworld.
com/29wpower) and a USB-C to 
Lightning cable.

iOS CENTRAL iPAD PRO ACCESSORIES

APPLE CALLS IT the 
Lightning to USB 
Camera Adapter, 
but it can be used to 
connect a variety of 
USB devices to your 
iPad Pro.  

THIS LIGHTNING-TO-USB-C CABLE lets you 
use the 29W USB-C power adapter 
(that typically comes with the 12-inch 
MacBook but is also sold separately) to 
charge your iPad Pro in half the time. 
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It’s something Apple should 
include with every iPad Pro, but until 
then it’s something every iPad Pro 
user should pick up.

The adapter itself is $49. In addition 
to the adapter, you’ll need a USB-C to 
Lightning cable. You can get a 1-meter 
cable (go.macworld.com/usbc2light 
ning1m) for $25, or double the length 
to 2 meters (go.macworld.com/usbc2 
lightning2m) for $35.

My tests have shown the standard 
12W power adapter will charge the 
iPad Pro in 5 hours, whereas the 
29W adapter cuts that time in half, to 
2.5 hours.

APPLE PENCIL
I’m not sold on the Apple Pencil (go.
macworld.com/applepencilrev) as a 
must-have accessory. I rarely ever 
use mine, save for the occasional 
jotting of notes and game of Sketch-
Party TV (sketchparty.tv) after its 

latest update.
Still, the Pencil is easily the best 

digital writing and sketching experi-
ence available on the iPad Pro.  
And for those who often need to  
sign documents, sketch product 
designs, or take notes in class, the 
Apple Pencil is the tool you want to 
have on hand.

At this year’s WWDC, hopefully  
we will learn more about Apple’s 
future plans for the iPad Pro, not  
only in terms of software, but also  
in allowing access to its Smart 
Connector. More importantly, hope-
fully Apple will begin giving more 
than just Logitech access to the 
connector’s tech.

As we recently saw with the Logi 
Base charging stand (go.macworld.
com/logibase), we’re only beginning 
to learn just how many tricks the 
connector has up its sleeve. ■

SINCE THE iPAD PRO is the 
only iPad that can use 
the Apple Pencil, that’s 
your best choice for a 
smart stylus. 
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Mophie launches wireless 
chargers to keep your phone 
powered up wherever you go
Mophie’s “Charge Force” products were designed to wirelessly charge your 

phone while at home, in the car, or the office.

BY OSCAR RAYMUNDO

iOS CENTRAL
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W ireless charging is slowly becoming more  

mainstream, but one company is going all-in to 

try to boost its adoption. In late May, Mophie 

(mophie.com) released three wireless chargers 

that can charge your Mophie-encased phone on contact. This 

“Charge Force” product line includes a charging pad for your 

nightstand, a vent clip for your car, and a desk mount for the 

office—all with built-in magnets to help stabilize your phone and 

keep it in place.

These wireless chargers require a 
compatible Mophie case. The 
company tells us that all Mophie 
cases moving forward will be 
equipped with this technology. In 
fact, Mophie’s Juice Packs for the 
Samsung Galaxy S7 that went on 
sale earlier this year are already 
Charge Force-compatible.

I got to try the Charge Force line 
for a little bit recently, and I was 
impressed with how strong the 

magnets were, which is definitely 
necessary if they’re meant to hold a 
phone with a battery pack. The vent 
clip for the car seems to be the most 
appealing choice. You can use it not 
only to charge your phone, but also 
to keep your phone up on the 
dashboard if you need to navigate 
for directions. Once you set up the 
vent clip, you won’t need to ever 
fumble around your car to find a 
charging cable ever again. I wasn’t 

MOPHIE CHARGE FORCE 
CHARGING PAD
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able to test it under real driving 
conditions, however, so I still have to 
see how well the phone stays in 
place once it’s charging, and how 
easy it is to remove the phone with 
one hand while on the road.

If you don’t drive very often but 
are still curious to try wireless 
charging, either the charging pad or 
the desk mount could work. But I 
wouldn’t recommend getting both. 
Sure, you may never experience 
“low-battery anxiety” with a charging 
pad at home, a desk mount at work, 
and a vent clip for all those times 
driving in between. But considering 
that the Mophie cases already boost 
your battery life—some by almost 120 
percent—I don’t see the need to 
have an entire wireless charging eco-
system everywhere you go. It’s 
important to have our devices 
charged at all times, but what’s the 
point of having them continuously 
charged to 100 percent day in and 
day out?

You can purchase the charging 
pad bundled with a Juice Pack right 
now starting at $99.95 on Mophie.
com (go.macworld.com/mophie 
wirelesschrgr), BestBuy.com (go.
macworld.com/mophiewirelessbb), 
and Apple.com (apple.com/search/
mophie). The vent clip and the  
desk mount are each available  
for $59.95. ■

iOS CENTRAL MOPHIE WIRELESS CHARGERS

TOP: Mophie Charge Force Vent Clip. BOTTOM: Mophie Charge Force Desk Mount.
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Hands-on with Vi, the fitness 
coach in your ear
This new activity tracker is like a Fitbit, Amazon Echo, and a pair of 

Beats rolled into one product.

BY CAITLIN McGARRY

iOS CENTRAL
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On an unseasonably hot Wednesday at the end of 

May, a little voice in my head was telling me to run 

faster. “It’s time to get your heart rate up,” she told me. 

This wasn’t my inner masochist, like it usually is. On 

this particular run, it was the voice of Vi, a digital assistant baked 

inside a pair of prototype in-ear headphones.

Vi is the first consumer product from 
wearable technology company 
LifeBeam, which has provided the 
tech backbone for products from 
Samsung, Under Armour, and JBL, 
among others. Now LifeBeam is 
partnering with Harman/Kardon for 
Vi, which debuted on Kickstarter (go.
macworld.com/kickstartervi) recently.

WHO IS VI?
At first glance, LifeBeam’s wrap-

around headset resembles the LG 
Tone, a pair of Bluetooth head-
phones with neck controls for 
volume. And while Vi can be used to 
jam out on your daily commute like 
any other Bluetooth headphones, 
this product is like no other I’ve used.

Vi combines a voice-activated 
digital assistant similar to Apple’s Siri 
or Amazon’s Alexa with the activity-
tracking features of a Fitbit band in a 
pair of LG-like headphones. The 

YOU CAN LISTEN TO 
music, answer phone 
calls, and get workout 
inspiration from this 
pair of Bluetooth 
earbuds.
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ear buds have a slew of sensors 
packed inside that track your heart 
rate, heart rate variability, motion, 
and elevation while you’re running. 
While you’re running, Vi will analyze 
your heart rate and tell you to speed 
it up to really burn some fat. With 
Spotify and Apple Music integration, 
Vi will select up-tempo tunes with the 
right beats per minute to get your 
blood pumping, and you can ask her 
to skip songs. Instead of glancing at 
your wrist to see your stats, just ask Vi.

There is no shortage of smart 
assistants, but none of them are a 
suitable personal trainer. That’s 
where Vi comes in.

HOW IT WORKS
When you unbox the headphones, 
you’ll pair them to your iPhone or 
Android device like any other 

Bluetooth product. Then you’ll enter 
your goals in the Vi app. Do you want 
to lose weight? Do you want to 
maintain your current fitness level? 
Are you training for a race? With all of 
this info, plus the data Vi collects 
from your body, you’ll get incredibly 
personalized training advice—or so 
LifeBeam cofounder and CEO Omri 
Yoffe told me during my demo of Vi 
on a treadmill in an office building 
just off Park Avenue.

You can chat with Vi verbally or via 
SMS, same as you would a real life 
personal trainer. If the weather is 
crappy, Vi will text you some advice 
to adjust your normal outdoor 
workout to an indoor training 
session. You can message Vi about 
your sleep or what you’re eating. Vi 
is HealthKit-integrated so the assis-
tant can read data from your other 

iOS CENTRAL VI FITNESS COACH

VI WILL TEXT YOU with 
exercise advice just 
like a personal trainer 
would.
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health apps if you grant access. 
Unlike an actual fitness coach, Vi 
won’t admonish you for skipping 
workouts or make you run stairs for 
eating poorly. It’s all about positive 
reinforcement, Yoffe told me.

FIRST IMPRESSIONS
Before I hit the treadmill with Vi’s 
voice in my ear, I was skeptical. “I’m 
not sure I would ever wear this 
running,” I wrote in my notes while 
watching another journalist take her 
turn on the treadmill. I’ve used a 
gazillion fitness trackers before, but 
none on my head.

I laced up some sneakers and 
hopped on the treadmill, earbuds 
snugly placed around my head. I 
started walking, and Vi told me my 
heart rate. Then she told me to 
increase my speed to get in the 
fat-burning zone.

We’re all used to talking to our 
devices by now, and chatting with Vi 
was no different. She responds to 
various commands, but you’re not 
gonna have a full-blown conversa-
tion. (Not that you’d be able to do so 
while running anyway.) When she 
told me my heart rate, I could actually 
hear the thump of my heart beating 
in my ears, which was both cool and 
slightly strange. The earbuds them-

selves were more comfortable than 
the cheap sport pair I bought but 
almost never use. The Harman/
Kardon sound was above average, 
as expected. I’m more interested in 
Vi’s possibilities, though. Yoffe told 
me that Vi is sort of like a fitness-
minded version of Samantha from 
the Spike Jonze film Her. One day, 
LifeBeam’s headset will be a pair of 
wireless 
earbuds that 
you can chat 
with any time.

I only tested 
out a prototype 
of Vi for a few 
minutes, but 
I’m intrigued to 
see if the final 
product turns out to be the personal 
trainer I so desperately need but 
don’t want to pay for. At launch, the 
device will work best for runners, but 
software updates will expand Vi’s 
training capabilities to swimmers and 
bikers down the line. The head-
phones will run continuously for eight 
hours on a single charge—not bad 
for a pair of Bluetooth earbuds.

Vi is currently available to preorder 
on Kickstarter for $199 and will retail 
for $249. The device starts shipping 
in December. ■

SHE RESPONDS TO 
VARIOUS COMMANDS, 
BUT YOU’RE NOT 
GONNA HAVE 
A FULL-BLOWN 
CONVERSATION.
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PARALLELS ACCESS 3.1:  
REMOTE ACCESS ON STEROIDS,  
NOW FOR iPAD PRO
BY J.R. BOOKWALTER

THE ABILITY TO REMOTELY access desktop computers on mobile 
devices feels futuristic every time I do it, but that captivation wears off 
right around the time I have to pinch and zoom to see what’s on screen 
or attempt to get any real work done from a remote system.

Luckily, there’s Parallels Access (go.macworld.com/parallels). Paral-
lels Access addresses these problems by allowing iOS and Android 
devices to not just access, but actually use Mac and Windows comput-
ers from anywhere there’s an internet connection. Rather than replicate 
the computer’s display like other virtual network computing (VNC) apps 
do, Parallels Access adapts larger screens to smartphones, tablets, or 
web browsers.

iOS CENTRALiOS CENTRAL

Reviews
iOS CENTRAL

ACCESS 3.1

mmmmh
AT A GLANCE

Parallels Access offers fast, 
optimized remote access to 
Mac and Windows computers 
from any iPhone, iPad, or 
iPod touch tailored expressly 
for mobile devices.

PROS

3D Touch on iPhone 6s

CONS

Thunderbolt Display

devices

on iPhone 6s

support for OS X Lion 10.7

PRICE

$20/year

COMPANY

Parallels
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MAKING THE CONNECTION 
Unlike traditional VNC apps, which 
typically cram entire desktop screens onto 
mobile devices, Parallels Access intelli-
gently adapts for smaller displays one 
window at a time. The agent software can 
be installed on up to five computers, and 
a single user account can access those 
systems from an unlimited number of iOS 
or Android devices for $20 per year (also 
included free with Parallels Desktop for 
Mac).

Parallels Access doesn’t just mirror your 
remote computer display—you’re instead 
presented with the App Launcher, which 
allows you to launch desktop apps in a 
way that’s similar to OS X’s Launchpad. 
Rather than clutter up the screen with 
rows of unwanted icons, you can select 
up to 24 favorite applications per screen 
from your remote system.

To launch a remote application, simply 
tap its icon. The desktop agent will 
optimize the Mac’s window to match the 
resolution of the device it’s being viewed 
from—your iOS device, presumably—and 
then moves desktop windows right back 
into place once disconnected. It’s easy to 
move between multiple windows or open 
applications from the App Switcher, but if 
you prefer to mirror the entire desktop 

TOP: Parallels Access 3.1 allows a single account to 
remotely access up to five Mac or Windows computers 
from an unlimited number of mobile devices. BOTTOM: 
The App Launcher is used for creating shortcuts to your 
favorite remote applications, each one available with 
just a tap.
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screen like other VNC apps, this can be done via Settings → Desktop 
Mode. 

Both viewing modes offer smart magnification when making a selec-
tion for precise control during text selection, drag-and-drop, or using the 
on-screen cursor. With the latest update, you can now move the cursor 
while using iOS 9’s new trackpad mode from the on-screen keyboard. 

MANAGE FILES 
Parallels Access also includes a full-fledged File Manager, which allows 
you to browse, copy, move, or delete files on remote computers. This 
comes in particularly handy for moving files created on an iOS device to 
a connected Mac or Windows PC, or vice versa.

File Manager also taps directly into cloud storage services like Drop-
box, Google Drive, and OneDrive, which can be used to copy or move 
files between local device storage and remote volumes. While con-
nected to one computer, you can also access files from others on the 
same account, rather than disconnecting and reconnecting. 

The exhaustive feature list doesn’t end there—while connected, 
Access can take advantage of the iOS microphone, and play audio from 
remote computers. If you don’t have a smartphone or tablet handy, you 
can connect from a modern web browser instead, although this method 
is not nearly as fluid as the mobile app. 

After picking up the 12.9-inch iPad Pro when it launched last Novem-
ber, I couldn’t wait to use it with Parallels Access. There was just one 

JUMPING BETWEEN multiple 
remote applications is a snap 
with the App Switcher feature 
in Parallels Access.

64



problem: While the existing app worked just fine, the developers hadn’t 
yet updated it for the more expansive display. Five months later, that 
support is finally here, and it was well worth the wait.

PRO RESOLUTION AT LAST 
Parallels Access 3.1 isn’t a revolutionary update, but adds a number of 
convenient improvements. In addition to screen resolution and virtual 
keyboard support for small and large iPad Pro models, iPhone 6s 
owners can now use 3D Touch for drag-and-drop or to access contex-
tual menus; Quick Action shortcuts from the home screen are absent, 
however. 

The update also introduces Apple Pencil support, which is an ideal 
companion for Parallels Access. Instead of relying on smart magnifica-

LIKE iOS and OS X, App 
Launcher icons can be 
organized into folders, but 
selections on one device 
don’t sync to others.
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tion to maneuver tiny on-screen buttons, you can now tap with excep-
tional accuracy. Other nice touches are the ability to consolidate icons 
into folders on the App Launcher (although they don’t yet sync between 
devices), and support for Windows 10 tablet mode, which turns the iPad 
into a faux Microsoft Surface.

The biggest 3.1 news is Desktop Resolution control. You can now 
select from three display options on the fly—Best For iPad, More Space, 
or Same As Computer—for more comfortable viewing. This feature 
works great with Apple Mail, Microsoft Excel, or just about any applica-
tion that could benefit from a little more breathing room. 

However, Desktop Resolution failed to work with my typical setup 
using a mid-2012 MacBook Pro with Retina Display connected to a 
27-inch Thunderbolt Display. It works fine with the larger display 
unplugged, although the second and third resolution options are effec-
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VERSION 3.1 introduces 
Desktop Resolution, with 
three settings for displaying 
windows from a remote 
computer.
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tively the same. The desktop 
agent no longer supports OS X 
Lion 10.7, so this feature was 
also a no-show on my mid-
2007 Mac mini, although 
remote access itself continues 
to work just fine.

BOTTOM LINE
With support for the latest iOS 
hardware including Apple 
Pencil, Parallels Access 3.1 
continues to be the absolute 
best way to use desktop 
applications from a mobile 
device. ■

REMOTE COMPUTERS MUST have the Parallels Access desktop agent installed, but 
version 3.1 removes support for OS X Lion systems.
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THE ROLL: iPHONE APP TAKES 
INTELLIGENT CHARGE OF  
YOUR CAMERA ROLL
BY JACKIE DOVE

ATTENTION iPHONE SHOOTERS: Just because 
you feel compelled to take 100 shots of your 
favorite local band’s holiday concert or that cute 
duck family in the park doesn’t mean locating 
the image you want or endlessly scrolling to 
find the best one to share on Facebook, 
Twitter, or Instagram won’t give you a mas-
sive migraine. It will.

That’s where The Roll (theroll.eyeem.
com), free on the iTunes Store (go.mac 
world.com/therollappstore), a new 
iPhone app from EyeEm, comes in. 
The Roll is designed to save you 
time and effort by automating the 
curation and organization of all the 
photos in your Camera Roll (The 
Roll—get it?), from scanning and 
tagging to quantitative quality 
ranking. The Roll offers a 
helping hand in deciding which 
ones to keep and ditch. The 
best photo, according to the 
app’s proprietary algorithm, 
always lands on top of the stack 
of similar ones, each accompa-
nied by an “aesthetic score” of 
between 0 and 100. That helps you 
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select which photos to share and which to lose.
The Roll works its magic with its proprietary image recognition tech-

nology, EyeEm Vision (go.macworld.com/eyeemvision), which automati-
cally tags and scores your photos and organizes images by topic, 
location, and event. The algorithm, based on computer vision and 
trained by millions of images, recognizes not only content but mood and 
emotion, which it uses to generate keywords. Browse your collection by 
tapping on a tagged image collection or searching via keyword. At 
launch, the app recognizes and tags some 20,000 keywords. As the app 
continues to analyze additional photos, it promises to improve accuracy.

In addition to using artificial intelligence to generate keywords, the 
app records metadata regarding your shots such as aperture, ISO, 
shutter speed, and focal length, plus a tiny map pinpointing location.

Some users have voiced privacy concerns, and for good reason. For 
the app to do its job of tagging and rating, your images must touch base 
with EyeEm’s server. While some users undoubtedly would prefer that 
analysis take place directly on the device, EyeEm vows that only small 
thumbnails are uploaded to its servers, where they are processed, and 
then promptly removed, and that transmission to and from the server 
goes via encrypted https protocol. EyeEm says no actual humans see 
your photo. The servers themselves were fairly speedy, with my Camera 
Roll of 250 new photos taking just over two minutes to process.

While the built-in iOS Photos app classifies your images according to 

THE ROLL

mmm
AT A GLANCE

iPhone app uses AI to 
automatically create 
keywords and records 
metadata for your photos.

PROS

your photos

time

CONS

albums other than the 
Camera Roll

PRICE

Free

COMPANY
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geolocation, date, and time, it eschews qualitative judgment on 
subjective quality issues like lighting, composition, focus, and subject. 
For most people, discerning the difference between nearly identical 
shots and scouring multiple shots on a small screen for fine details or 
color gradations remains a challenge.

Overall, The Roll was helpful in either pointing me in the right 
direction or at the very least offering an alternative point of view. That 
said, I often disagreed with—or did not see the logic in—some of The 
Roll’s picks, and aside from the rating, there’s no hint of why or how the 
app came to its conclusion. It never divulges why some images carry a 
higher rating than others.

According to EyeEm, the methodology of ranking photos is generally 
a combination of artistic photography principles combined with its 
deep-learning technology, but there’s no explanation for specific 
individual photos. 

With this debut, users should be aware of a few things. First, you 
must be connected to a Wi-Fi network to use The Roll.

Second, the app sees only images directly in the Camera Roll folder 
of the iPhone’s Photos app—not in other albums you may have stored 
on your iPhone. For example, I tried importing a batch of photos via 
iTunes into the camera app for a test, but The Roll would not recognize 
those photos, as they were not added to the Camera Roll, but to 
different albums.
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The keyword function was strong overall, but while the keywords 
were abundant, they sometimes seemed vague. For example, a picture 
of my cat was tagged as “pet, animal, whisker, animal eye” and more. 
The one thing it did not list was “cat,” which is unfortunate because that 
would be my search term.

The Roll is free and available on the iOS app store. It works on the 
iPhone and iPad right now, but even with an up-to-date operating 
system, I found iPad operation buggy at best.

BOTTOM LINE
You have nothing to lose, and perhaps some insight to gain, in giving 
The Roll a try. It’s very easy to use; all you need to do is launch the app 
and it takes care of the rest. Its keywording skills are laudable, if not 
perfect, and that alone is worth the price of admission. As for choosing 
the best photos from your collection—that was sometimes hit or miss—
but its third-party neutral perspective was nonetheless intriguing. As a 
brand-new release, The Roll’s debut is auspicious, but it still has a way to 
go to accomplish the goals to which its creators aspire. ■
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What’s new  
at the  
App Store

BOOM: MUSIC 
PLAYER
The free Boom: Music Player app 

(globaldelight.com/boomforios) for 

iOS promises to let you hear your 

tunes in highest-quality stereo, 

promising 3D Surround Sound, a 

16-band equalizer, an “intensity 

slider,” and more. One warning: It 

only works for your downloaded 

music files, not streaming music.
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Model 15
By far the most expensive app we’re 
featuring, check out the $30 Model 15 
(go.macworld.com/model15app)—an 
electronic recreation of the beloved 

synthesizer that first appeared in 1973. (And a 
cheaper version at that: Hardware models report-
edly cost $10,000 or more.) Love some groovy 
old-school keyboard sounds? This is your app. 
Warning, though: Only 64-bit devices are supported.

Clawtar
Clawtar ($6 for iPad; clawtar.info) is “a 
musical instrument and MIDI controller 
with an adaptive interface.” The 
interface is laid out with the keys and 

buttons placed where your hands might most 
naturally rest on the iPad screen, meaning it’s not 
only musical but ergonomic, intended to let you play 
by touch instead of sight.

LikeSo
LikeSo ($1, iPhone and iPad; sayit-
likeso.com) helps improve your public 
speaking skills: Speak into your iOS 
device and the app calculates how 

often you use “filler” words—“um,” for example—and 
scores you accordingly. The goal? To prepare you 
for interviews, presentations, auditions, and more.

Sharply
Sharply (free, iPhone and iPad; 
sharplyapp.com) is a “personal brain 
trainer” that features more than 25 
games—with more new games 

available each month—to help you stay, natch, 
sharp.  —JOEL MATHIS



BY EMANUELA CORSO AND MARCO TABINI 

Protect Your iPad
This week’s roundup of iPad cases features Toast's personalized wood cover, 

Twelve South's functional BookBook, a waxed canvas sleeve from Dodocase, 

and a messenger bag that comes with it's own tracking number.  

BRENTHAVEN
The Medina (all iPad models; $100; 

brenthaven.com) is a messenger bag 

with plenty of room for your tablet 

and larger electronics. The bag 

sports a fashionable two-tone 

exterior with a genuine leather trim, a 

dedicated pocket for your iPad and 

your laptop, and a front panel for 

accessories that’s secured by a 

magnetic closure. For extra peace of 

mind, each Medina bag comes with 

an individual tracking number that 

can be used to trace it back to its 

owner if it’s lost or misplaced.

TOAST
The Custom Cover (9.7-inch and 12.9-inch iPad Pro, all iPad Air 

and iPad mini models; $69 to $99; toastmade.com) is made from 

wood obtained from ecologically sustainable sources. The case 

grants full access to the iPad’s buttons and ports, can be 

personalized with your own logo or favorite artwork, and is 

available in walnut, bamboo, ebony, or ash.

73



GRIFFIN 
The Snapbook with Keyboard (9.7-inch 

iPad Pro and iPad Air 2; $100 MSRP; 

griffintechnology.com) combines a 

folio-style case with a removable 

Bluetooth keyboard. It features a soft 

interior lining designed to prevent 

scratches and smudges, a sturdy TPU 

shell that should withstand drops from 

up to six feet, and raised edges to 

keep your screen safe when placed 

face-down on flat surfaces.

TWELVE SOUTH
The just announced BookBook (9.7-inch and 

12.9-inch iPad Pro, iPad Air 2 and iPad mini 4; 

$100; twelvesouth.com) for the new 9.7-inch 

iPad Pro sports a vintage book design 

secured by dual zippers with bookmark-like 

leather pulls. Made with distressed leather, 

the case features two hardback sides lined 

with microfiber and a reinforced spine to 

absorb and dissipate impact from shock. The 

BookBook can be used to draw, type, and 

even Net surfing in standing mode and 

includes a convenient pocket inside its spine 

to store your Apple Pencil.
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DODOCASE
The stylish Durable Sleeve (9.7-inch iPad 

Pro; $69.95; dodocase.com) combines a 

waxed canvas exterior with a cotton twill 

interior. Designed to hold your iPad Pro 

with or without a Smart Keyboard, the 

sleeve features a three-layer construction 

with a leather tab closure, and comes in 

midnight, sage, or navy.

THINKGEEK
The Bag of Holding (all iPad models and iPad 

Pro; $35; thinkgeek.com) features lots of 

pockets and compartments for everything 

you’ll need when traveling—or for navigating a 

tech conference or fan convention. Its main 

attraction is a front pouch, whose hinged 

design and vinyl cover allow you to use your 

iPad without having to take it out of the bag. A 

complement of shoulder straps and handles 

give you plenty of carrying options, and special 

grommets between the various compartments 

make it possible to thread cables through for 

easy charging and tethering between devices.
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TIPS AND TRICKS TO GETTING THE MOST OUT OF APPLE’S 

FOURTH-GEN SET-TOP BOX. BY CAITLIN McGARRY

MUST-KNOW 
SECRETS AND 
SHORTCUTS FOR 
YOUR APPLE TV

ILLUSTRATION BY SHAW NIELSEN
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After installing your favorite streaming apps (go.mac-

world.com/strm) and playing some of the games (go.

macworld.com/atvgames) designed just for tvOS on 

your Apple TV, you’re probably wondering what else 

this set-top box can do.

There are a slew of under-the-radar features that let 

you customize your TV to your heart’s 

content and make it much easier to use. 

Apple just released tvOS 9.2, which 

baked a ton of functionality into the 

device (including some features from 

older TV models).

Here are 30 tips and tricks to make  

the most out of your fourth-generation 

Apple TV. 

FEATURE     30 M UST- KNOW SECRE TS F O R YOU R A PPLE T V

APPLE TV SETTINGS,  
SIRI REMOTE TRICKS, AND MORE
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SIRI SEARCHES 
ACROSS APPS

1 Searching for stuff to watch on 
your Apple TV just got a whole 

lot easier with the help of Siri. If you 
search for a movie or TV show from 
the home screen, Siri will search 
across several apps, including iTunes, 
Netflix, Hulu, Showtime, and HBO. If 
you open one of those apps and use 
voice search, Siri will show results just 
in that app. There are tons of tips and 
tricks to using the new Siri remote 
alone, so check out our list of Siri 
commands (go.macworld.com/atvsiri) 
and more touchpad remote shortcuts 
(go.macworld.com/atvremote).

If you need an assist or don’t know 
what to ask, just press the micro-
phone button on the remote and Siri 

will offer a few prompts.

AUDIO OPTIONS
2 When you’re playing a video, a 

quick swipe down on the 
trackpad reveals some audio options. 
Reduce Loud Sounds will attempt to 
smooth out jarring changes in 

1

2
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volume (handy for loud commercials 
in some TV streams), but Full 
Dynamic Range is the default. If the 
app you’re using supports closed 
captioning or foreign language 
subtitles, you can control that here. 
You can also select different speak-
ers, which is great if you have a 
receiver or soundbar that supports 
AirPlay, or even paired Bluetooth 
headphones if you don’t want to 
wake the baby.

WHEN ‘SWIPE DOWN’ 
WON’T DISAPPEAR

3 When you’re watching a show 
or movie in an app like Hulu or 

YouTube, you can swipe down for 
more options as it plays. But if the 
Swipe Down For Info alert doesn’t 
disappear after a few seconds, which 
happened to Macworld’s Susie Ochs 
frequently in Hulu, either pause and 
restart the video to make it disap-

pear, or press Menu to go back one 
level and then restart the video.

NEW AERIAL 
SCREENSAVERS

4 If you love the Aerial screen-
saver, head to Settings → 

General → Screensaver, and with 
Aerial selected in the Type field, you 
can change the Download New 
Videos field from Monthly to Weekly 

3
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or even Daily. Just be aware new 
videos are downloaded in batches of 
about 600MB. You can’t customize 
which views you’re shown in Aerial, 
though—no restricting it to just your 
favorite city, for example.

CHOOSE YOUR OWN 
SCREENSAVER

5 You can use your own photos 
as screensavers instead of the 

stunning aerial options Apple pre-
loaded on the TV. Open the Photos 
app on your TV and then select an 
album you want to use as the screen-
saver carousel. Tap the screensaver 

option to set that album as your 
screensaver. You can change up your 
screensaver at any time by going to 
Settings → General → Screensaver → 
Screensaver Type.

CREATE APPLE  
MUSIC PLAYLISTS

6 Apple Music subscribers can 
add to existing playlists or 

create new ones straight from the 
Apple TV. Pick a song to play, then 
use the touchpad to tap the More 
option (denoted with the ellipses) at 
the top of the Now Playing screen. 
Then tap Add To Playlist and pick 
one to add to, or select New and give 
your playlist a name. If all goes well, 
iCloud Music Library will sync the 
playlist across all your devices.

JUST LIKE  
THE iPHONE

7 Apple TV has an app switcher 
of its own—just double-tap the 

6



TV button on your Siri remote. You 
can close apps by swiping up on the 
touchpad remote.

GET RID OF 
UNWANTED APPS

8 How to delete apps after 
installing them: Navigate over 

to the unwanted app and highlight it, 
then press down on the touch 
surface of your Siri remote until the 

app jiggles, just like it would on an 
iOS device. Press the play/pause 
button on the remote, then tap 
Delete. As on iOS devices, you can’t 
remove native tvOS apps that 
shipped with the device.

FREE UP  
STORAGE SPACE

9 The new Apple TV comes with 
32GB or 64GB of space, 

depending on how much you spend. 
If you’re an app-hoarder with a 32GB 
version, you’ll need to keep a close 
eye on how much room you have left 
by tapping through Settings → 
General → Manage storage. You’ll 
see a full list of apps stored on the 
TV and how much space they take 
up. You can delete the most egre-

9

FEATURE     30 M UST- KNOW SECRE TS F O R YOU R A PPLE T V

82



gious space-hogs by highlighting and 
tapping the trash can icon next to 
each app, or you can delete apps 
directly from the home screen.

MOVE APPS AROUND 
THE HOME SCREEN
10 If you just want to move an app 

without deleting it, follow the 
same steps as you would to delete it: 
Highlight it and press down on the 
touch surface to make the app jiggle. 
Instead of hitting the play/pause 
button, just use the touchpad to 
swipe side to side or up/down and 
move the app around.

PUT THE TV TO BED
11 You can’t power down the new 

Apple TV, but you can put it to 

sleep. Just hold 
the home 
button, which 
will prompt the 
TV to ask if you 
also want to 
turn off devices 
connected to 
the TV—this means your television 
set. Press the home button once to 
turn it back on again. You can also 
put the TV in sleep mode by going to 
Settings → Sleep Now.

TWO TIPS TO 
RESTART
12 So you can’t turn off your Apple 

TV, but you can reboot it if you 
need to by tapping through Settings 
→ System → Restart. If that doesn’t 

10
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work for some reason, hold down the 
menu and home buttons on the Siri 
remote at the same time, then let 
them go when your display starts 
flashing.

ADD MULTIPLE APPLE 
IDS TO YOUR TV
13 Multiple people can use the 

Apple TV in your house, and 
they don’t have to load up your 
account with their purchases if you 
don’t want them to. Associate 
multiple Apple IDs with your TV by 
adding a new Apple ID under Set-
tings → Accounts → iTunes And App 
Store. After the new ID is added, your 
family members can switch to their 
accounts under Settings → Accounts 
→ iTunes And App Store. If they install 
apps on the TV under their account, 

those apps will remain on your home 
screen.

SKIP FORWARD,  
JUMP BACK
14 Siri can handle many of the little 

tasks you want to perform on 
your Apple TV, like fast-forwarding or 
rewinding content you’re watching. 
But you can also skip back and forth 
through a movie or show using the 
Siri remote: Press the right side of 
the touchpad to skip 10 seconds 
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forward, and press the left side to 
skip back 10 seconds.

PAIR BLUETOOTH 
ACCESSORIES TO 
YOUR TV
15 You can only pair one Siri 

remote to a fourth-gen Apple 
TV, but you can pair two additional 
Bluetooth accessories: Either two MFi 
Bluetooth game controllers, or one 
game controller and one Bluetooth 
audio accessory, like headphones or 
a speaker. Pair your accessories to 
the TV by tapping through Settings → 
Remotes And Devices → Bluetooth 
and selecting the device you want to 
pair.

FORGET BLUETOOTH 
DEVICES
16 If you want to swap out one of 

your paired Bluetooth accesso-

ries for another one, just unpair one 
under Settings → Remotes And 
Devices → Bluetooth. Pick the acces-
sory you’re done with, then select 
Forget Device.

USE THE APPLE TV 
REMOTE TO CONTROL 
YOUR DISPLAY
17 Turn your Siri remote into your 

main TV remote, or at least give 
it some extra functionality, by letting 
it control your TV power and volume. 
Let your Apple TV remote turn your 
TV on and off by tapping through 
Settings → Remotes And Devices → 
Turn On Your TV With Your Remote. 
To enable your Apple TV remote to 
control your TV’s volume, select 
Settings → Remotes And Devices → 
Volume Control.

ACTIVATE VOICEOVER
18 The Siri remote offers an 

accessibility assist for people 
with low or impaired vision. Ask Siri 
to turn VoiceOver on, or navigate to 
Settings → General → Accessibility → 
VoiceOver. As you highlight text with 
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the touchpad remote, VoiceOver will 
read the text aloud. You can pause 
VoiceOver by tapping the touchpad 
once with two fingers. Tap twice with 
two fingers to resume VoiceOver. 
Check out more VoiceOver controls 
in Apple’s TV support documents (go.
macworld.com/atvsup). 

MAGNIFY YOUR 
SCREEN
19 There are a slew of other 

accessibility options supported 
by the Siri remote. Turn on the Zoom 

feature in Settings → General → 
Accessibility → Zoom to use the 
remote’s touchpad to magnify Apple 
TV images, focus in on a particular 
area of the screen, pan across an 
image, or change the magnification 
of the screen. See all of the Zoom 
options here (go.macworld.com/
atvzoom). 

FAMILY SHARING
20 You can use Family Sharing on 

the Apple TV to watch movies 
or TV shows family members have 
purchased. Open iTunes, then select 
Purchased → Family Sharing and pick 
the name of family members from the 
menu bar. You have to use a Mac, 
iPhone, or iPad to set up Family 
Sharing (go.macworld.com/atvfam) 
before you get started on the TV. 

18

20

FEATURE     30 M UST- KNOW SECRE TS F O R YOU R A PPLE T V

86



USING SIRI TO  
FIND APPS
21 The fourth-gen Apple TV is the 

first to have a tvOS App Store, 
but when the hardware shipped, it 
was almost impossible to find apps. 
Apple has cleaned up App Store 
search by adding categories, but the 
real game-changer was adding Siri 
integration. Now you can search for a 
specific app by name without hunting 
and pecking to tap through letters on 
the remote. You don’t even have to 
launch the App Store for Siri to start 
searching. Just say, “Hey Siri, search 
the App Store for Netflix.”

You can also just ask Siri to recom-
mend some titles for you. A search for 
find good games turned up Solitaire, 
Crossy Road, and Jetpack Joyride 

(which I had never heard of but I’m 
now intrigued). You can also search by 
developer name, if you’d like.

SET UP BLUETOOTH 
KEYBOARD SUPPORT
22 What could be better than 

searching the App Store with 
your voice (and a little help from Siri)? 
Using a keyboard to type your query 
directly into the TV search bar. The 
Apple TV supports Bluetooth key-
boards with tvOS 9.2, so make sure 
your TV is up-to-date and your key-
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board discoverable. Then go to Settings 
→ Remotes And Devices → Bluetooth 
and select the device you want to pair.

If you’re using a Magic Keyboard 
(go.macworld.com/kb), there’s a slew 
of shortcuts (go.macworld.com/atvsc) 
you can use with the new Apple TV:

F3: Switch apps
F4: Go to home screen
F7: Rewind
F9: Fast forward
F8: Play
Spacebar: Pause
F11: Decrease volume
F12: Increase volume

DICTATE TEXT WITH 
YOUR VOICE
23 Siri makes searching for apps 

or content within apps a lot 
easier, but entering text—like your 
Apple ID and password—is still a 

pain. Instead of typing in those letters 
and numbers, let voice dictation do 
the work for you.

When a keyboard pops up on 
screen, press and hold the micro-
phone and spell out your username or 
password. Apple’s passwords are 
case-sensitive, so make sure to say 
“uppercase” when capitalizing a letter.

If you messed up, just say “clear” 
to erase all text.

A cool privacy note: Apple usually 
processes the information you relay 
through Siri And Dictation, but not 
with usernames and passwords you 
speak to your Apple TV.

WATCH LIVE 
CHANNELS
24 With Siri support, Apple added 

a U.S.-only feature called Live 
Tune-in, which lets you jump to live 

23
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content in supported apps. Those 
apps are: CBS, CBS News, Disney 
Channel, Disney Jr., Disney Xd, 
ESPN, and FXNow. To access Live 
Tune-in, just hold the microphone 
button in one of the apps mentioned 
above and say, “Watch CBS live” 
(replace CBS with the name of the 
app you’re using), then release the 
microphone button.

SHARING PHOTOS 
FROM YOUR MAC TO 
YOUR TV
25 Flipping through a photo album 

on your Apple TV is a great 
party trick. Apple now supports Live 
Photos shot on an iPhone 6s or 6s 
Plus, too. But there’s a trick to getting 
photo albums from your Mac to show 

up on your TV.
Open iTunes on your Mac, then 

click through File → Home Sharing → 
Choose Photos To Share With Apple 
TV. Select Share Photos From, then 
pick either All Photos or a specific 
folder you want to share. Then click 
Apply. Those photos will now appear 
in the Computers app on your TV, not 
the Photos app (a little confusing). 
But don’t worry, they’re there.
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ORGANIZE YOUR 
HOME SCREEN WITH 
APP FOLDERS
26 Take control of your Apple TV 

home screen (go.macworld.
com/atvhm) so it’s as personalized as 
your iPhone by creating category-
specific folders.

You can do this two ways: Press 
down on the touchpad until the apps 
start jiggling, then drag one app on 
top of the other so they’ll expand to 
create a folder, similar to how apps 
on your iPhone and iPad home 
screen do. Or highlight an app, press 
and hold the touchpad until the icon 
starts to jiggle, then press the play/
pause button and select New Folder. 
That will allow you to create a new 
folder and edit its name.

GIVE APPS TOP ROW 
PRIVILEGES
27 After you’ve made folders, 

decide which apps you use the 
most and move them to your top row. 
Apple has given Apple TV apps in 
the top row a special power: the 

26
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ability to preview content in those 
apps before opening them. For 
instance, highlight Netflix and see 
what shows and movies are trending 
now in the top bar, or highlight Music 
to see which albums you’ve recently 
added to My Music. Not every 
third-party app developer has built 
TV previews—looking at you, Vevo—
but it’s a great way to see the latest 
content without opening the app.

PAUSE VIDEO  
TO SWIPE
28 One of my favorite things about 

my Apple TV is the ability to 
swipe through content using the Siri 
remote touchpad. It makes it super 
easy to find specific scenes and jump 
around a show or movie whenever I 

want. But tvOS 9.2 changed the way 
that swipe function works. Now, 
instead of just swiping as the video 
plays, you have to press pause to 
swipe. At first I thought Apple had 
ditched the swipe feature and I was 
beyond peeved, but don’t worry: It still 
exists, just in a slightly less useful way.

AIRPLAY ON APPLE TV 
IS GREAT FOR GROUPS
29 The Apple TV is the focal point 

of your living room, but you can 
also use it for work. AirPlay makes 
the TV easier to use in both settings.

To use the TV as a conference room 
display so anyone can share their Mac 
or iOS screen to the device, just go to 
Settings → AirPlay → Conference Room 
Display and create a custom message 
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so that everyone in the room can see 
on-screen that the TV is in Conference 
Room Display mode. (You don’t want to 
accidentally share your screen with the 
world.) You can choose a background 
photo if you want, then lock the TV in 
Conference Room Display mode with a 
4-digit pin. This keeps anyone from 
using the TV as a, well, TV, without 
knowing the code. This feature was 
previously only available on older 
Apple TVs, but tvOS 9.2 brought it to 
the fourth-gen device.

You can also use AirPlay as a way 
to have friends beam content to your 
TV without giving them access to 
your Wi-Fi network, thanks to the 
peer-to-peer AirPlay functionality 
introduced in iOS 8.

USE YOUR iPHONE  
OR APPLE WATCH  
AS A REMOTE
30 The fourth-gen Apple TV wasn’t 

the easiest to use when it 
launched last fall. Apple waited months 
to add robust Siri support, Bluetooth 
keyboard integration, and one of the 

easiest ways of all to control the TV, 
the Remote app for iOS. We wondered: 
What gives (go.macworld.com/atvrem)? 
It took a while, but the Remote app for 
iOS and the Apple Watch does now 
work with the new TV. How it works: 
Pair your phone and your TV by 
opening the Remote app and entering 
the 4-digit pin into your TV under 
Settings → Remotes And Devices → 
Remote App.

That’s it! Now when you open your 
Remote app on the iPhone, its screen 
acts as a Siri remote touchpad. You can 
also set up the Remote app using 
Home Sharing—
just select that 
option in the iOS 
app, then enter 
your Apple ID and 
password. It will 
find the other 
devices connected 
to your account that have Home 
Sharing turned on (so make sure you 
enable it on your TV if you’re going 
that route).

To enable the Remote app on your 
Apple Watch, make sure it’s paired to 
an iPhone that’s on the same Wi-Fi 
network as your Apple TV. Open the 
watch Remote app, then tap Add 
Device. It’ll give you a 4-digit pin. Enter 
that pin under Settings → Remotes And 
Devices on your TV. Then you can use 
your watch to swipe through options or 
pause/play content. ■
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HEADPHONES BUYERS GUIDE:

Which type 
delivers the best  
balance of  
great sound, 
isolation, and 
comfortable  
fit?
IN THE EAR, OVER 
THE EAR, OR ON THE 
EAR: WE EXAMINE 
THREE HEADPHONE 
TYPES AND NAME 
THE BEST FOR 
MUSIC LOVERS.
BY THEO NICOLAKIS

94



I
n-the-ear, on-the-ear, and over-the-ear 

headphones all sound different. They 

also have their respective benefits and 

drawbacks. We set out to explore which 

kind of cans provides the best mix of noise 

isolation, comfort, price/performance ratio, 

and sound quality with a wide range 

of music.
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ROUNDING  
THINGS UP
For this roundup, I focused on 
headphone models priced less than 
$300. I then solicited some advice 
from Harman International’s Director 
of Acoustic Research, Dr. Sean Olive 
(seanolive.blogspot.com), who is also 
a former president of the Audio 
Engineering Society (aes.org/aes/
seanolive). Dr. Olive and his col-
leagues have been at the forefront of 
headphone research, and Harman 
provided a number of headphones 
for this evaluation.

After auditioning them, I settled on 
the JBL Reflect Mini in-ear monitors 
(IEMs), the AKG N60 NC (noise-can-

celling) on-ear headphones, and the 
JBL Everest Elite 700 over-the-ear 
headphones. I listened to each  
both at home and on the road to  
see how the different form factors 
performed in a variety of environ-
mental conditions.

IN-EAR-MONITORS
In-ear-monitors fit into your ear with 
either a silicone or foam tip. As with 
most IEMs that I own or have tried, 
the JBLs were light and comfort-
able—to the point where I’d forget I 
was even wearing them. My biggest 
complaint with IEMs at this price 
point is that you get a smaller sound 
stage and concede some of the 

HARMAN PROVIDED a wide variety of 
headphones from its AKG, Harman/Kardon, 
and JBL brand portfolio.

FEATURE     H E A DPHO N ES BU Y ERS G U I DE

JBL EVEREST 
ELITE 700 
HEADPHONES
PRICE WHEN RATED

$300

JBL REFLECT 
MINI IN-EAR 
HEADPHONES
PRICE WHEN RATED

$55

AKG N60 NC 
ON-EAR 
HEADPHONES
PRICE WHEN RATED

$250
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dynamics, richness, and sweetness 
you’ll typically get with on-ear or 
over-the-ear models. Bass can also 
be hit or miss.

Getting a tight seal with IEMs is very 
important because the bass response 
you’ll get is dependent on that seal. If 
the seal is too loose, bass will sound 
anemic. While IEMs are great for 
orchestral, jazz, and even certain kinds 
of pop and rock, they wouldn’t be my 
go-to phones for explosive bass or rich 
dynamic pieces.

Typically, IEMs come with different 
sized tips to provide the best fit with the 
unique shapes of your ears. The tips 

help secure the IEM into your ear as 
well as block out ambient noise—some-
times to the tune of 25db or more. 

While the JBL Reflect Mini (go.
macworld.com/jblreflectminiamz) did a 
decent job of blocking out external 
noise, it wasn’t a stellar performer. I 
therefore reached out to a third-party 
company, Comply, which manufactures 
replacement tips from memory-foam 
(complyfoam.com) for various brands 
of in-ear monitors. These promise to 
block out more external noise than the 
silicone tips that come with most IEMs. 
And they live up to that promise, in my 
experience. They were a noticeable 

THE COMPLY 
REPLACEMENT 
memory-foam tips 
made a dramatic 
difference in 
blocking ambient 
noise when paired 
with the JBL Reflect 
Mini in-ear monitors.

97



upgrade from what came in the 
package with the JBLs—especially in 
high-ambient-noise situations, such as 
inside airplanes and trains.

ON-EAR 
HEADPHONES
For me, on-ear headphones (also 
called supra-aural) can be hit or miss. 
Some models are too tight and 
others far too loose. While tight-fitting 
models can help block out external 
noise, they can become fatiguing and 
painful to wear for extended periods. 
The AKG N60s (go.macworld.com/
akgn60ncamz), however, felt just 
right. They were super light and 
comfortable—even for very long 

listening sessions.
Another advantage of on-ear 

headphones is that they give you 
close to the sound quality of over-
the-ear headphones in a more 
compact form factor. In fact, many 
models, including the AKG N60, fold 
for travel.

Whether it was Adele’s “Hello,” 
U2’s Songs of Innocence, or Holly 
Cole’s Best of, the AKG N60s effort-
lessly reproduced just about any 
artist or genre I threw at them.

NOISE-CANCELLING 
HEADPHONES
On-ear-headphones tend to be at a 
disadvantage in noisy environments. 

AKG’S N60 
headphones fold for 
easy travel

FEATURE     H E A DPHO N ES BU Y ERS G U I DE
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For that reason, some models, includ-
ing the N60, feature active noise 
cancellation: They generate back-
ground noise that’s roughly an 
inverse sound wave to the noise you 
want to eliminate.

Not all noise cancelling techniques 
are the same. Aimed at air travelers, 
the AKG N60’s noise cancelling 
targets lower frequencies to cancel 
out most of the aircraft’s engine 
noise. I can say from first-hand 
experience that the effect is quite 
impressive. In contrast, the JBL 
Everest Elite are focused on a 
broader commuting and at-home 
audience, so they employ a wider 
noise-cancellation spectrum.

While the effects might at first 
seem magical, there are definite 
drawbacks that I noticed immediately. 
First, enabling active noise cancelling 
on any headphone—not just the AKG 
N60 or JBL Everest Elite 700—cre-
ated a noticeable pressure on my 
ears. While this sensation might not 
bother some, it certainly bothered me 
and reminded me why I’ve never 
liked noise-cancelling headphones.

Second, active noise cancelling 
effects the soundstage and (depend-
ing on the model) the musical pre-
sentation. For example, activating 
active noise cancellation immediately 
recessed the soundstage, making 
the overall presentation more 
relaxed. I found that it also thinned 

NOISE CANCELLATION isn’t just for on-ear models. Some over the 
ear models, such as JBL’s Everest Elite 700s feature active noise 
cancellation, too.

out the music. The effect was far 
more noticeable (and bothersome to 
me) in quiet environments as 
opposed to noisy ones. 

All in all, while I know many 
people love active noise-cancelling 
headphones, I much prefer a good 
seal (aka passive noise cancellation).
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OVER-THE-EAR 
HEADPHONES
Over the ear headphones (also 
known as circumaural or full-sized 
headphones) are an audiophile gold 
standard for good reason. This type 
of headphone fully covers your ear. 
Open-back designs let you hear your 
surroundings. Closed-back models 
help seal out ambient noise and 
prevent sound from leaking into the 
environment (and nearby micro-
phones, if you’re in a recording 
studio). Several times while I was 
wearing the JBL Everest Elite 700s 
(go.macworld.com/jbl700eliteamz), I 
was completely unaware that some-
one was speaking to me. I just didn’t 
hear them. Circumaural headphones 
significantly lower the noise floor, 
allowing you to hear more details 
and get “deeper” into the music.

On a nearly 11-hour transatlantic 
flight I recently took, for example, I 
measured 94dB of cabin noise 
using a SPL (sound-pressure level 
meter). The JBL Reflect Minis (with 
the Comply memory-foam tips) and 
the JBL Everest Elite 700 did the 
best job of isolating my ears from 
that cabin noise. I preferred listen-
ing to music and movies, however, 
through the over-the-ear JBLs 
because of the superior overall 
sound quality.

Music comes from a wide, expan-
sive soundstage with either open- or 
closed-back circumaurals. Instru-
ments take on a larger, more lifelike 
feel. This was certainly the case with 
the JBL Everest Elite 700. Orchestral 
works in particular benefit, but so 
does R&B. The larger drivers in an 
over-the-ear headphone deliver a 

FEATURE     H E A DPHO N ES BU Y ERS G U I DE

OVER-THE-EAR 
headphones, such as 
those of the JBL 
Everest Elite 700 
pictured here, 
typically feature 
plush, large ear cups 
that seal out ambient 
noise for a lower 
noise floor when 
listening to music.
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OVER-THE-EAR 
headphones are 
typically far larger 
than on-ear models.

better sensation of bass, too. 
Listening to Lorde’s “Royals,” for 
example, was a very different 
experience on the Everest Elite 
headphones compared to what I 
heard using the Reflect Mini ones. 
Generally speaking, over-the-ear 
headphones are better suited to for 
all kinds of music.

The biggest drawback of over-the-
ear headphones is their size and 
bulk. Over long listening sessions 
with the JBL Everest, my ears 
became a bit hot and uncomfortable. 
For that reason, I preferred wearing 
the AKG N60s or Reflect Minis for 
long sessions.

MACWORLD 
RECOMMENDS
While they aren’t the best for travel 
or an active lifestyle, over-the-ear 

headphones deliver the best bal-
ance of sound quality, noise isola-
tion, and comfort. In-ear monitors 
deliver the best overall price/
performance ratio, and they can be 
great for jogging or workout ses-
sions. A good pair of on-ear head-
phones, which let your ears 
“breathe,” can be worn comfortably 
during long listening sessions, and 
models with active noise cancella-
tion go a long way to making up for 
the reduced isolation those models 
typically provide.

Each type of headphone comes 
with its own pros and cons; and in 
an ideal world, we’d all be able to 
have all three types at our disposal. 
Everything else being equal, if your 
budget limits you to one type, we’d 
recommend circumaural cans over 
anything else. ■
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WORKING MAC Tips, Tricks, and Tools to Make You 
and Your Mac More Productive

How to use one 
Mac in multiple 
rooms
A reader wants to have a single machine 

available with a monitor and keyboard in 

multiple, adjacent rooms.

BY GLENN FLEISHMAN
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Baril wonders if display mirroring 
would solve the problem.  

Yes! Any iMac model with two 
Thunderbolt ports can support one 
monitor via each port (go.macworld.
com/thunderboltfaq) using the 
DisplayPort video standard, which uses 
the same connector type and passes 
over the Thunderbolt standard.

You’ll also need to think about what 
resolution displays you want to use. 
You can get a 21.5-inch iMac either 
standard 1080p resolution (1920x1080 
pixels) or 4K (4096x2304 pixels), or 
the 27-inch iMac with 5K (5120x2880 
pixels). The 21.5-inch models can 
handle two 1080p displays (or there-
abouts), while the 5K iMac can 
support two 4K monitors.

Depending on how close the other 
rooms are and how much you can drill 
through a wall or run cords over a 
partition, you will probably need 
longer than a typical DisplayPort 
cable, which is normally about 6 feet 
(2 meters) or shorter. Affordable, 
longer DisplayPort cables can’t carry 

4K, which isn’t an issue for any but the 
27-inch iMac. But keep that in mind. 
Monoprice has a 15-foot Mini Display-
Port to HDMI cable (go.macworld.
com/displayportcable) for $16. (Most 
DisplayPort capable monitors will also 
have an HDMI port.)

If you need longer distances or 
want 4K from a 27-inch iMac, it’s 
possible, but you’ll spend several 
hundred dollars, as you have to leap 
to high-end ethernet style or fiber-
optic cabling with converters.

Next, you can set up mirroring, so 
that both external displays mirror the 
internal one. Apple has detailed 
instructions (go.macworld.com/
applemirror) about enabling mirroring 
and Option-dragging displays onto 
the main one. Because your external 
displays will be lower resolution, OS 

Jean-Francois Baril has 

a complicated problem 

to solve: He needs to 

have two monitors that 

mirror his iMac display, so that 

he can buy one iMac and use it 

in three different adjacent 

rooms (in a doctor’s office).

THUNDERBOLT display 
settings.
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WORKINGMAC MONITOR MIRRORING

X will figure out the lowest compat-
ible dimensions among all the 
monitors connected.

Finally, you need keyboards and 
mice or trackpads. Bluetooth is your 
best bet, as most keyboards support 
a signal-strength flavor that carries 
about 30 or so feet (10 meters), 
reducing by walls and other obsta-
cles. I’d make sure the keyboard and 
pointing device used with the main 
Mac is plugged in via USB, because 
Bluetooth can only support 7 devices 
at a time, and Apple recommends 

(go.macworld.com/bluetoothmac) 
using only 3 or 4 at once.

Of course, with keyboards and 
displays in different rooms, you’ll 
have to make sure that multiple 
people aren’t trying to use the same 
computer at once. It’s still just a 
single session you’re working with 
mirrored across multiple displays. 
You could find yourself confused 
when you struggle to move the 
mouse pointer onscreen as it keeps 
getting dragged elsewhere. ■
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Every 8 minutes the American 
Red Cross responds to a disaster 
and makes this promise. This holiday 
season, you can help us keep it.

Donate today at redcross.org

This is how you say 
it’s going to be okay.



5 ways to search Gmail that 
everyone should know about
Use Gmail’s advanced search operators to find anything in your inbox.

BY MICHAEL ANSALDO

WORKINGMAC
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These terms can help you home in 
on what you’re looking for more 
quickly and accurately than a simple 
search. There are dozens of opera-
tors you can use, but we’ve narrowed 
down five of the most handy.

1. USE ‘IN:ANYWHERE’ TO 
SEARCH EVERYWHERE
It’s a given that a general Gmail search 
crawls every nook and cranny of your 
inbox, right? Alas, no. Search ignores 
Spam and Trash unless you specifically 
tell it to look there. That’s important to 
know because even Gmail’s spam filter 
is imperfect. And who hasn’t acciden-
tally consigned some important 
message to the trash when furiously 
trying to get to inbox zero?

If you have no idea where the 

In a perfectly productive world, your inbox would have a place 

for every email with every email in its place. But it’s easy to let 

messages stack up knowing Google’s powerful search can 

usually bail you out when you need to find a months-old 

missive. Still, there will be cases when you need the help of an 

advanced search operator.

message you need is hiding, cast the 
widest net possible with the 
in:anywhere operator followed by a 
keyword. This should uncover your 
missing email, provided it hasn’t 
been sitting in your trash or spam 
folder for more than 30 days, after 
which time Google will automatically 
delete it.

2. FIND ATTACHED FILES 
WITH ‘FILENAME’
Your meeting is about to start and 
you still haven’t found the Excel 
spreadsheet your colleague emailed 
you last week. There’s no time to 
scroll through the hundreds of 
messages in your inbox looking for 
it—you needed it five minutes ago. 
Here, the filename: operator can 

USE THE FILENAME: operator to search attachments by filename or type.
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save your day.
Just pair it with any part of the file 

name—for example, if the file was 
called fiscalQ3.xlsx you can type 
filename:fiscal to search for any 
attachment with “fiscal” in the file 
name. You can also use this operator 
to search by file type if you don’t 
remember the filename. In this 
example, you’d type filename:xlsx  
to find any Excel attachments.

3. USE ‘BEFORE’ AND ‘AFTER’ 
TO SEARCH TIME PERIODS
Often you have a rough idea of when 
a message was received even if you 
can’t remember the exact date. 
That’s when to use this pair of 
operators.

You can use them individually to 
find a message that was sent before 
or after a specific date by typing 
before: or after:, respectively, 
followed by the date in the yyyy/mm/
dd format. You can also use these 

operators together to search within a 
window of time—
after:2016/02/15 

before:2015/03/01, for example.

4. SEARCH BY STAR FOR 
IMPORTANT EMAILS
If you’re not already familiar with the 
full range of Gmail’s colored-star 
system (go.macworld.com/gmail-
stars), it’s time to bone up. It not only 
offers an easy way to prioritize 
important messages without having 
to drag them to different folders or 
set up complex filters, it also makes 
them easier to search for later.

Using Gmail’s has: operator, you 
can search for messages tagged with 
a particular star. For example, 
has:red-star. This search is even 
more powerful when you pair it with 
the from: operator to find a starred 
message from a specific sender—
type has:red-star from:Frank to 
find emails received from Frank that 

GMAIL SEARCH

YOU CAN USE the 
has: operator 
to find messages 
marked with a 
particular colored 
star.
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you’ve marked with a red star.

5. DON’T FORGET TO  
CHECK CHAT
A lot of work communication takes 
place in Google Chat because of its 
real-time nature. Fortunately, your 
chat logs are stored in you Gmail 

account and you can use advanced 
search to find important information 
buried in snippets of conversation. 
Just pair the is:chat operator with 
a keyword or the name of the 
person you chatted with—is:chat 

Susan, for example—to find what 
you need. ■

109



Eye in the sky asset management 
using Watchman Monitoring
Watchman Monitoring offers excellent options for consultants, enterprise and education 

IT managers to track and proactively monitor the computer assets they’re responsible for.

BY JEFFERY BATTERSBY

WORKINGMAC
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WATCHMAN 
MONITORING DOES your 
busywork by way of 
software installed on 
a client computer.

Fun times, yes?
For the last several weeks I’ve been 

testing the Watchman Monitoring 
service (watchmanmonitoring.com), a 
web-based tool that uses a System 
Preference installed on every com-
puter you own or manage to help you 
inventory and keep track of your Mac, 
PC, and Linux assets. Watchman 
Monitoring not only automatically 
collects information on all your 
devices, it also provides proactive 
monitoring of those devices, warning 
you about critical issues before they 
become real problems. Watchman 
Monitoring offers excellent options for 
consultants, enterprise and education 
IT managers to track and proactively 
monitor the computer assets they’re 
responsible for.

Watchman Monitoring is designed, 
and priced, for consultants, busi-
nesses, and educational institutions. 
Accounts start at $249 per month for 
up to 1,500 computers. You can 
purchase more licenses in increments 
of 1,000 for $100 more per month.

For smaller businesses, Watchman 
Monitoring expects you to use their 

Asset management? Your first thoughts likely run to 

databases of devices. Fixed. Immutable. Manual 

entry. A pain to change and keep up-to-date. Maybe 

even a walking tour of your building(s) every year to 

make sure the numbers in your database match your numbers 

on the floor.

consultants network (go.macworld.
com/watchmannetwork). Consultants 
can offer monitoring for far fewer 
computers and can also give you 
access to your own account so you can 
see and monitor your own computers. 

 [Full disclosure: My business is a 
member of the Watchman Monitoring 
consultants network.]

WHAT WATCHMAN 
MONITORING WATCHES
Watchman Monitoring does your 
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busywork by way of software installed 
on a client computer—a System 
Preference on the Mac—that sends 
status updates, at an interval you 
specify, so you can keep your thumb 
on critical issues. What does Watch-
man deem critical? Computers that 
haven’t checked in, devices that aren’t 
backing up, hard drives about to fail, 
and a host of other issues (go.mac-
world.com/wmwatchlist), including 
those related to third-party software 
products. When a problem arises, you 
and anyone else on a list of users you 
define, are notified by email of the 
issue at hand.

For Macs the service offers several 
installation options, including stan-
dard package installers, imaging 
installations, using Apple’s Netinstall 
service or JAMF Software’s Casper, 
and command-line scripts that can 
silently push an installation out using 
Apple Remote Desktop. This is also 
true of Linux and Windows installa-

tions, although as I was testing this 
the Windows version of the client 
was in a pre-version 1 state, which is 
to say that, while not technically a 
beta, it had limited features and 
wasn’t quite up to speed with the 
Mac and Linux versions.

Once the Watchman software is 
installed, the device it’s installed on 
registers with the Watchman service. 
You have the ability to add devices to 
groups, making it easy for you to 
organize devices by company, client, 
office, or floor. At present the service 
doesn’t offer an option for subgroups, 
although I was able, through creative 
group naming, to organize devices into 
smaller device groups based on client 
and location. Once devices are added, 
it’s dead simple to move devices to 
different groups or to merge one or 
more groups with each other.

SO, INVENTORY?
Once you’ve installed the software, 

WATCHMAN MONITORING

ONCE YOU’VE 
INSTALLED the 
software you have an 
instant inventory of all 
your computers.
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you have an instant inventory of all 
your computers. Select Computers 
from the Watchman dashboard and 
you’ll see a complete list of all the 
devices with the Watchman software 
installed, sortable by computer name, 
group, serial number, or the last time 
it reported in.

To that end, if a computer fails to 
report in for a few days, you’ll also 
get a message that the computer is 
missing. From this list you can export 
a CSV file that includes data from the 
four displayed columns or a complete 
report, which provides a detailed 
overview of all your devices, similar 
to Apple Remote Desktop’s system 
overview report.

The devil, as they say, is in the detail 
and Watchman Monitoring offers a 
considerable quantity of detail. Select 
any computer in the list and you’ll see 
a significant amount of information, 
including whether any malware was 
detected, whether disks experienced 
I/O errors or kernel panics, when the 
computer’s last full POST was, and how 
much capacity the computer’s hard 
drive has available.

You can also keep your own notes 
on specific devices and view historical 
information, including everything from 
OS updates to software version 
updates. Watchman Monitoring can 
also detect when you have remote 

control software 
installed on a 
computer, such as 
TeamViewer, 
LogMeIn, and 
Bomgar, and 
automatically 
adds a link to the 
device’s overview 
page, allowing 
you to remotely 
control the device.

While all of this 
is incredibly 
detailed and 
fantastically easy 
to use, Watchman 
Monitoring’s killer feature is its 
proactive warning system, which 
detects errors early. The benefit of 
this feature was obvious within 
minutes of installing the plug-in. One 
of the computers I was testing was 
experiencing disk errors via the 
SMART warning system, which were 
not showing up in Disk Utility: There 
was a continuously increasing 
number of bad sectors on a hard disk. 
Which is to say that, over a 24-hour 
period the hard drive was reporting 
new sector errors. This proactive 
reporting allowed me to replace a 
hard drive before it failed, saving the 
test computer from unnecessary and 
prolonged downtime. ■

WATCHMAN 
MONITORING’S KILLER 
feature is its proactive 
warning system, 
which detects errors 
early.
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How the Smart Connector could 
be key to an iPhone Pro
As each iPhone gets more powerful, Apple could turn the iPhone Plus into an iPhone Pro 

by adding one little port, a good dock, and a whole new world of expansion possibilities.

BY MICHAEL SIMON

WORKINGMAC

114



A recent schematic leak (go.mac-
world.com/ip7schematicleak) seem-
ingly provides some evidence for the 
inclusion of a Smart Connector on 
the next-generation iPhone Plus. 
Depending on which rumor (go.
macworld.com/ip7smartcxtr) you 
want to believe, it appears that Apple 
is wrestling with the decision to 
christen the larger 5.5-inch iPhone 
with the same Pro status it bestowed 
on the iPad, complete with the 
addition of the magnetic Smart 
Connector. According to the drawing 
and a previous leaked photo, the 
port is located on the back of the 
device, rather than the edge like on 
the iPad Pro, which suggests Apple 
has something different in mind than 
just a tiny Smart Keyboard.

With the iPad Pro, the Smart 
Connector is the first step toward 
positioning the tablet as a laptop 
replacement, but its purpose on a 
potential iPhone Pro isn’t quite so 
straightforward. And whether it 
happens this year or next, I think it’s 

Ports are the unsung heroes of Apple’s biggest revolu-

tions. We got USB with the iMac, FireWire and the 

30-pin connector with the iPod, Lightning with the 

iPhone and iPad, and USB-C with the new MacBook. 

Whether the ports are fledgling or proprietary, Apple’s biggest 

breakthroughs have often centered around a new way to con-

nect and charge, and its latest one might be making a surprise 

appearance on the next iPhone.

a logical step for the continued 
growth and maturation of the iPhone.

BUILDING BLOCK
In its current form, the Smart Connec-
tor’s intelligence basically boils down 
to its ease of use. Like the Microsoft 
Surface’s Type Cover (go.macworld.
com/mstypecover) that clearly 
inspired it, the Smart Connector is 
built specifically to work with the 
Smart Keyboard; just attach it to the 
magnetic connector and start typing, 

APPLE'S SMART 
BATTERY Case 
doesn't have to be 
beautiful, since it 
removes every bit of 
friction involved in 
using other battery 
cases. 
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without dealing with, as Apple says, 
“cords, pairing, or plugs.” Other than 
that, it’s no smarter than using a Blue-
tooth keyboard.

But the potential of the Smart 
Connector is much greater than an 
attached keyboard. Like the switch to 
USB on the iMac or Lightning on the 
iPhone, Apple is making a somewhat 
complicated process just a little bit 
easier. Like every great thing Apple 
does, simplicity is key.

Take Apple’s often-maligned Smart 
Battery Case (go.macworld.com/
applebatterycaserev). Uncharacteris-
tically ugly and bulky, its beauty isn’t 
in its outer aesthetics but rather its 
inner elegance. Unlike other pow-
ered cases that require you to 
constantly monitor your levels, 
Apple’s solution seamlessly switches 
between the internal and external 
batteries until they’re both drained, 
keeping you constantly notified of 
each.

It could be that the Smart Battery 
Case is a precursor to the kind of 
functionality the Smart Connector will 
enable. A series of swappable 
add-on cases and modules would 
give the iPhone the customization 
users desire while still letting Apple 
control the experience. Things like 
camera controls and lenses, extra 
storage, and, of course, batteries 
could make the iPhone the first 
successful modular phone, while 

giving 6 and 6s users a significant 
reason to upgrade.

GOING PRO
Along with cases, the positioning of 
the connector naturally lends itself to 
comfortable placement in a dock. 
While a series of kits might expand 
the functionality of the iPhone, a 
dock could allow Apple to use the 
Smart Connector to change the 
perception of the iPhone, much like it 
did with the iPad Pro. Assuming it’s 
part of a rebranding of the 5.5-inch 
model from Plus to Pro, it offers an 
opportunity to pivot from a powerful 
handset to a small next-generation 
mobile computer.

Despite a proliferation of third-
party charging stands, Apple only 
offers a single, bare-bones iPhone 

SMART CONNECTOR

SLAP THE iPAD Pro in  
a sturdy charging 
dock and grab any 
handy Bluetooth 
keyboard … kinda 
works like a computer. 
The iPhone Pro could 
do this, too.
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Lightning Dock for $49, and it took 
Logitech to create the Logi Base (go.
macworld.com/logibase), an iPad Pro 
dock that uses the Smart Connector 
for charging. But with the iPad Pro, a 
keyboard makes the most sense, and 
while I’m quite sure Logitech is 
already prototyping an ultra-portable 
Smart Keyboard for the iPhone, I think 
Apple’s plans are bigger than typing.

A Smart Dock could expand the 
iPhone’s capability in ways that just 
aren’t possible now. For example, a 
speaker dock could make the Hey 
Siri function rival the usefulness of 
Amazon’s Echo. An audio dock could 
turn your iPhone into a Sonos-like 
sound system. And an Apple Watch–
style magnetic inductive charging 
dock would take a little bit of friction 
out of having to charge your iPhone 
every night.

But the most intriguing potential 
for a Smart Dock is on the desktop. 
Apple’s Pro devices are all linked by 
their ability to let you work faster 
and more efficiently, and a desktop 
charging dock that expands the 
iPhone to a larger screen or offers 
the ability to connect 
a hard drive would be 
a real game changer  
for the iPhone, 
expanding it far 
beyond its current 
capabilities.

On the iPad Pro, 
the Smart Connector 
might be little more 
than an easy way to 
connect a keyboard, but its potential 
is far greater. It could be the thing 
that turns the iPhone from smart to 
genius. ■

A SPEAKER DOCK 
COULD MAKE 
THE ‘HEY SIRI’ 
FUNCTION RIVAL 
THE USEFULNESS 
OF AMAZON’S 
ECHO.
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The initial release of iTunes 12 came with a confusing interface. With the 12.4 

update, Apple has thankfully made iTunes simpler to use.

BY KIRK McELHEARN

Apple simplifies navigation 
with iTunes 12.4
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selected, you see, by default, 
Recently Added, Artists, Albums, 
Songs, Genres, and Music Videos. If 
you right-click anywhere in this 
section and choose Edit List, you 
can add Composers and Compila-
tions, or remove any of the view 
options if you prefer. Click Done, or 
click anywhere else in the sidebar to 
save your changes.

It makes more sense to have a 
sidebar entry for Recently Added 

When I reviewed iTunes 12 back in 
late 2014, I said, “Overall, I find the 
navigation confusing—it requires too 
many clicks to get around.” I find the 
changes Apple has wrought to the 
interface of iTunes 12.4 to be both 
positive and intuitive, and I think all 
users will find these new ways of 
navigation to be more efficient, once 
they get used to them.

Navigating iTunes is now—or, 
again—centered on the sidebar and 
a single menu in the navigation bar. 
(You can show or hide the sidebar in 
the View menu.) Instead of a lot of 
confusing media kind buttons in the 
navigation bar, there is now a popup 
menu that Apple calls the Media 
Picker. Click it to choose a media 
library, edit the Media Picker menu, 
or mount another iTunes library with 
Home Sharing.

When you’ve selected a media 
library, you can then access its 
contents from the sidebar. Under the 
Library header, you’ll see a number 
of ways to access your media. For 
example, when the Music library is 

Apple recently released iTunes 12.4, simplifying some 

of the complex navigation features that have been 

criticized in this version of the media management 

app. Apple’s release notes for iTunes 12.4 say: “Now 

enjoy all of your music, movies, TV shows, podcasts, and more in 

a simpler design.” You can update iTunes through the App Store 

app on your Mac.

CHOOSE A MEDIA 
library from this  
pop-up menu.
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view options—such as how your 
content is sorted, whether artwork 
displays, and which columns are 
visible in list views—choose View → 
View Options, or press Command-J.

It’s interesting that 
iTunes now gives you 
more options for 
artwork size; in non-list 
views, you can choose 
from five sizes, up from 
three previously.

Another confusing 
interface element that 
has been improved is 
the Back and Forward 
buttons at the top left of 
the iTunes window. In 
iTunes 12.3, these 
buttons only displayed 
when you viewed the iTunes Store, 
and only affected navigation in the 
store. Now, they affect all your actions 
in iTunes: whether in your own library, 
Apple Music, or the iTunes Store. 
(There are also keyboard shortcuts for 
these buttons: Command-[ and 
Command-].)

Apple has thankfully merged the 
two different types of contextual 
menus, in most locations. Instead of 
one menu displaying when you click 
the … button, and another when you 
right-click an item, the menus are the 
same, and work in the same way. I 
never understood why Apple wanted 
these two menus to be different, but 

than to pile this content up at the top 
of the various views, as it was before. 
But I do not see any way to change 
the scope of this selection (weeks, 
months, etc.).

Also gone is the View Options 
menu, which was previously at the top 
right of the iTunes window. To change 

THE VIEW OPTIONS window is back; it’s now much 
easier to choose which columns you want to view, 
and more.

THE SIDEBAR IS back, and it’s your 
control center for accessing your 
iTunes content.
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it’s good that it’s 
realized how 
confusing they 
were.

Unfortunately, 
there are some 
locations where 
the “new” 
contextual menu 
exists; click the 
… button next to 
an artist or 
album name, 
and the new 
menu is still 
there. There’s 
also a new Song 
menu in the 
menu bar, which reproduces the 
menu items from the contextual 
menu.

The iTunes LCD—the display 
section at the top of the window—
has been simplified, removing the Up 
Next button (it’s now to the right of 
the iTunes LCD), bringing back the 
repeat button (why had that ever 
been removed?), and adding a visible 
♥ button. You could ♥ a track previ-
ously by hovering the cursor over the 
iTunes LCD, clicking the … button, 
and then clicking ♥. See how much 
of an improvement this is?

One change that’s a bit surprising 
is the removal of the buttons below 
the sidebar that let you create a new 
playlist or smart playlist. These 

functions are now in the File → New 
menu, as is Genius. There is no 
longer a way to start Genius from the 
contextual menu, and no more 
Genius suggestions; now, you select 
an item, and choose File → New → 
Genius Playlist. This is a bit obscure; 
could it be a hint that the Genius 
feature will be deprecated? (Genius 
also hasn’t been working well for a 
while; even for many popular songs, 
it is unable to create playlists.)

There are still some elements of 
iTunes that need a refresh. Apple 
Music Connect is still present, even 
though Apple has hinted that it would 
be removed. You still cannot get from 
the iTunes Store to Apple Music; if 
you want to stream a track you see in 

NOW, IN MOST of 
iTunes, there's just 
one type of contextual 
menu.

PODCAST
go.macworld.
com/podcast508 
to listen to our 
weekly podcast 
about the new 
iTunes 12.4
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the former, you have to manually 
search for it in the latter. But this may 
change when Apple Music is 
refreshed, most likely in June.

This update addresses many of the 
criticisms I’ve had regarding iTunes 12 
since its inception. Bringing back the 
sidebar, simplifying the navigation of 
media libraries and views, and the 
Back and Forward buttons help make 

iTunes simpler and more intuitive. The 
playlist functions are a bit hidden, and 
it would be nice to see color again in 
the sidebar, but the changes in iTunes 
12.4 make this app more usable.

There are a lot of little changes 
I’ve spotted in the latest version of 
iTunes that aren't discussed here. 
Learn more about those changes (go.
macworld.com/itunes124chgs). ■

EVEN THE iTUNES LCD 
has been simplified.
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Use keyboard shortcuts to 
better navigate iTunes 12.4
It’s quicker and easier to get around the app and control it from the keyboard.

BY KIRK McELHEARN

PLAYLIST
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ber these shortcuts, and you’ll save a 
lot of time.

CREATE NEW PLAYLISTS
There used to be buttons at the 
bottom left of the iTunes window, 
which you could click to create 
playlists and playlist folders. They’re 
gone now. You can right-click in the 
sidebar and display a contextual 
menu which offers these options, but 
only at specific locations: at the 
header that says Music Playlists or All 
Playlists, or below the playlists. If you 

It’s true that, for some features, you 
now need to click a bit more. For 
example, there was previously a row 
of icons near the top left of the 
iTunes window. These icons let you 
change media libraries, going from 
Music to Movies, or TV Shows to 
Audiobooks. But now, there’s a menu 
that Apple calls the Media Picker; you 
need to click that menu to choose a 
media library.

Actually, there’s another, quicker 
way to switch media libraries. You 
can do this from the keyboard. And 
there are lots of other keyboard 
shortcuts you can use in iTunes to 
save time. Here’s on overview of the 
most useful ones.

CHANGE MEDIA LIBRARIES
In addition to using the Media Picker, 
you can also access media libraries 
from the View menu. Choose View → 
Media Kind, and you’ll see a sub-
menu with all of the libraries.

To switch to your Music library, 
press Command-1. For your podcasts, 
it’s Command-4. And so on. Remem-

Apple released iTunes 12.4, changing a number of 

interface elements users had become familiar with 

for navigating their iTunes libraries. There are fewer 

buttons, and the interface is less cluttered (at least 

that’s my opinion) but some users are lamenting the loss of 

some of these buttons and menus, which allowed them to move 

around iTunes with just a few clicks.

THIS MENU SHOWS you 
keyboard shortcuts for 
switching media libraries.
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have a lot of playlists, you have to 
scroll to the bottom of the list, and 
the target is quite small.

Use the keyboard. As you can see 
in the File → New menu, there are 
shortcuts for New Playlist, Playlist 
From Selection, Smart Playlist, but 
not Playlist Folder.

You can use keyboard shortcuts to 
create new playlists, and you can 
even set up your own shortcut using 
this method (go.macworld.com/
osxshortcuts) if you create playlist 
folders often.

GO BACK AND GO FORWARD
iTunes 12.4 has Back and Forward 
buttons, similar to those you find in a 
web browser. You can use these to 
move around iTunes. For example, if 
you’re in your music library and you 
then go to the iTunes Store to look for 
a new album by your favorite band, 
you may want to go back to check 
what’s in your library. You can click the 
Back button, look at the band’s music, 
then click the Forward button to go to 
the iTunes Store again.

But you don’t need to use these 
buttons. You can press Command-[ to 
go back, and Command-] to go 
forward.

RATE SONGS
It takes a few clicks to rate songs in 
iTunes. You have to select a song 
and right click, or click the … button 

next to a song, then choose Rating, 
and then choose a star rating. (In 
Songs or Albums views, you can 
hover your cursor over a track and 
click one of five dots that displays.)

But you can also do this from the 
keyboard. While there are some 
third-party iTunes controllers that 
offer this feature, you can set up 
keyboard shortcuts in System 
Preferences that use the ★ charac-
ters in the Rating menu. See this 
article (go.macworld.com/rateitunes-
tracks) to find out how to do this.

You can set ratings from None to 
★★★★★ from the keyboard with this 
method.

MORE CONTROLS
There are other controls you can 
access from the keyboard.

> Press the spacebar to play and 

YOU CAN CREATE playlists from 
this menu, or by using the 
keyboard shortcuts you see 
here.

PLAYLIST iTUNES 12.4 SHORTCUTS
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pause your music and videos.
> Command–up arrow and Com-

mand–down arrow turns the volume 
up and down.

> Command–right arrow goes to 
the next track in an album or playlist, 
and Command–left arrow goes to the 
previous track. Note that if you’re 
further into a track than a few sec-
onds, Command–left arrow takes you 
to the beginning of the track; press it 
again to go to the previous track.

> Command-period stops what-
ever is playing and clears the iTunes 
LCD.

> Command-L goes to the cur-
rently playing song. (My favorite 
iTunes shortcut.) 

If you’re not used to using key-
board shortcuts with iTunes, take 
some time to learn some of these. 

CREATE YOUR OWN shortcuts to rate your music from the keyboard.

It’s quicker and easier to get around 
the app and control it from the 
keyboard. ■  
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Answers to your questions about Apple’s media app.

BY KIRK McELHEARN

How to trip out with 
the iTunes visualizer
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left corner of the window for a few 
seconds. That way, you can always 
glance at your display when a new 
track starts playing to see what it is.

 If you want the visualizer to fill your 
display, choose View → Enter Full 
Screen, or press Command-Control-F. 
When you’ve had enough of your 
show, press Command-T to stop it.

TURN ON THE LIGHTS
A quick press of two keys triggers 
the visualizer: while listening to 
music, just press Command-T, and sit 
back and watch the show.

 As you can see in the screenshot 
below, the visualizer displays the 
name of the track and album, its 
artist, and its artwork, at the bottom 

S ince its very first version, iTunes has had a visualizer, a 

built-in light show that you can use to play trippy ani-

mations while you listen to music. (Grateful Dead music 

not required.) You may not have ever used it, or even 

known it’s there, but it’s a lot of fun to turn on while listening to 

music, if you’re not working on your Mac (or if you just want to 

take a break). Altered states might make it even more interesting, 

but it’s a great way to have some captivating visuals when you’re 

just hanging out with friends listening to your favorite tunes. 

Here’s how it works.

START YOUR 
iTUNES light show 
by pressing 
Command-T.
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 If that’s all the visualizer did, it 
would be pretty cool, but it gets a lot 
better. If you choose View → Visual-
izer, you’ll see that you can choose 
from several different plug-ins. 
There’s also a Play Videos setting. 
Select this if you’re playing music 
from a playlist that contains music 
videos, and you want iTunes to play 
the videos when it gets to them, 
rather than use the visualizer.

TWEAKING THE VISUALIZER
The more changes there are in the 
music, the livelier the visualizer will 
be. You’ll see that percussive songs 
lead to a lot of effects, but the 
visualizer also adapts to mellow 
music to provide a constantly chang-
ing palette of colors and shapes. (To 
be fair, I find it a bit too busy for 
ambient music, where the lights 

should be more relaxing. But read on 
to learn how you can change that.)

 Try with different songs and see 
how the visualizer changes. By default, 
it uses a random setting that cycles 
through a number of presets. But you 
can change the visualizer’s settings 
too. Press ? (the question mark symbol) 
to see your options. Here are the 
options for the iTunes visualizer.

> The M key changes the mode, 
which is the overall set of shapes that 
the visualizer uses.

> Pressing P changes the palette, 
or the color scheme of the visualizer.
> The I key displays track info at 

the bottom left of the screen; this is 
what you see in the first screenshot, 
showing the track name, album, 
artist, and artwork. It fades away 
after a while.

> Press C to toggle the auto-

THE VISUALIZER 
DISPLAYS keyboard 
shortcuts for its 
settings when you 
press the ? key.
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cycle. This is on by default, and this 
tells the visualizer to change mode 
and palette at random. If you find a 
mode and palette you like, press C 
to keep that combination.

> The F key toggles freeze mode. 
If you see a visual you like, press F 
to freeze it so you can take a 
screenshot. This doesn’t freeze the 
display entirely, but it greatly 
reduces the movement, telling the 
visualizer to rotate but not dance 
around the display. This is a lot 
better for ambient music, which, as I 
mentioned above, dances too much 
with the default settings.

> Press N to toggle nebula mode 
(though some modes don’t display 
nebulae). This adds iridescent clouds 
to the display. If you press E while in 
this mode, the clouds are enhanced.

> The L key toggles camera 
mode. This locks the visuals to 
more or less the same position on 
the screen. Pressing F and L (not at 
the same time) gives you an idea of 
how these two settings are related. 
When both are engaged, there is 
very little movement. 
 The following keys aren’t shown 

on the Help screen:
> The A and S keys add or subtract 

rays in the current mode.
> The + and – keys increase or 

decrease the brightness of the rays.

> The R key resets rays and their 
brightness to their defaults. 

 Note that you can pause and 
resume playback while the visualizer 
is active by pressing the spacebar, 
and you can skip tracks by pressing 
the right-arrow (next) or left-arrow 
(back) keys.

 You can choose from other 
visualizers by selecting one in the 
View → Visualizer menu. The settings 
available for each visualizer are 
different. For the iTunes Classic 
Visualizer, see this article (go.mac 
world.com/visualizersecrets). It’s a lot 
less interesting than the newer 
iTunes visualizer.

 You can make lots of interesting 
desktop backgrounds using the 
visualizer. Just press Command-
Shift-3 to take a picture of the screen 
at any time; it will be saved on the 
desktop. Open System Preferences, 
click Desktop & Screen Saver, then 
Desktop. Drag an image to the well 
near the top of the window to use it 
as your wallpaper. ■

Ask the  
iTunes Guy
Have questions of your own for the 
iTunes Guy? Email itunesguy@
macworld.com for his consideration.
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Tips About Getting the Most From Your Mac

Mac 911
Solutions to your most vexing Mac problems.

BY GLENN FLEISHMAN

How to export a Live Photos movie into OS X

Q: As I understand it, a Live Photos image has a .jpg file and a .mov file: 
the still JPEG shown normally and the MOV file “activated” when viewing 
the live portion (either on the iPhone 6s or in photos).

— Sarah Kruberg

A: She took a number of Live Photos on a trip, but discovered after importing 
them and deleting them she couldn’t figure out how to get access to the 
movie files.

LIVE PHOTO COURTESY OF APPLE
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Apple makes it both easy and 
opaque. When you import a Live 
Photo into Photos for OS X, the app 
tags it: you can see the Live Photos 
icon in the lower left corner of a full 
preview of the image alongside the 
text label Live, and the icon also 
appears if you view information 
about the photo (Windows → Info). 
Hover over the Live label when 
viewing the full photo, and it plays 
the associated movie.

However, Photos doesn’t give any 
indication a .mov file exists. The Info 
palette only says it’s a JPEG; if you 
select File → Export → Export [X] 
Photo(s), it exports a JPEG. It’s only 
when you Option-drag an image into 
the Finder or select File → Export → 
Export Unmodified Original For [X] 
Photo(s) are both the unmodified JPEG 
and the associated MOV retrieved.

You can also use the Image 
Capture app with an iPhone con-
nected via USB, select the iPhone, 
choose Live Photos images, and then 
import them, and both the JPEG and 
MOV for each image are transferred.

iCloud.com only shows the JPEG 

version; there’s way no way to view a 
Live Photo or export a MOV, but it 
does retain those files and sync them 
among iOS and OS X.

How to exclude your iCloud 
Photo Library from an 
iTunes backup

Q: According to Apple Support (go.
macworld.com/iclouditunesback 
up), an iTunes backup of an iOS 
device with iCloud Photo Library 
enabled should not include photos 
from iCloud Photo Library. However, 
I’m currently experiencing that 
iTunes does indeed include all 
photos—something that I register 
from the size of the device backup in 
iTunes.

— Jan Dong-Hyun Dyrvig

A: Jan wonders how to prevent this 
from happening. I don’t experience 
this myself, and I’ve checked around 
the usual forums and can find only a 
couple of other people reporting the 
same—and no solutions they’ve 
found. You can try Apple’s direct 

AT LEFT, THE Live Photos label on an image; at right, 
the Info palette’s petite indicator.
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Should two-factor 
authentication let me 
verify via a single device?
Allen thinks something is off with 
Apple’s two-factor authentication 
(2FA; go.macworld.com/apple2factor) 
system which is a replacement for its 
older two-step verification system. 
He’s verified his MacBook and his 
iPhone, but notes that when he logs 
in via a browser to the Apple ID site 
or iCloud.com using his MacBook…

Q: …my MacBook will display a map 
with the option to select Don’t 
Allow or Allow. When I select Allow, 
I then get a pop-up with my verifi- 
cation code. Using this verification 
code, I’m able to log in with no 
issue. The issue here, however, is 
that I’m logging in with my Mac-
Book but also getting my verifica-
tion code on the same MacBook. Is 
this how it’s supposed to work?

— Allen

iCloud support (getsupport.apple.
com), as this seems related to an 
iCloud feature, or you can try reset-
ting your iCloud status.

Jan has iOS set to keep full-resolu-
tion images stored, which means that 
disabling iCloud Photo Library won’t 
cause a problem in which only low- 
resolution (optimized) images are 
stored.

1. In Settings → iCloud, tap Photos.
2. Tap the iCloud Photo Library 

switch to off. 
3. When prompted, you can opt 

to tap Download Photos & 
Videos to ensure that all 
iCloud Photo Library media 
gets stored in iOS. 

4. You should be able to now set 
iTunes to separately sync all 
the photos on your devices to 
iPhoto or Photos.

5. Perform an iTunes backup of 
the device, and check the 
size. It should now be smaller 
by the size of your iOS Photo 
Library. 

6. Re-enable iCloud Photo 
Library and wait until every-
thing is done syncing, which 
can take a while. iCloud 
shouldn’t duplicate or re-
upload any images.

7. Now perform an iTunes backup.
If all has gone well, your iTunes 

backup should now be the correct 
size and exclude images. 

WHEN DISABLING 
iCLOUD Photo Library, 
you can retrieve full-
resolution media or 
delete them.
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A: He sees the same 
map and code on his 
iPhone, if it’s turned on. It 
seems a little counter-
intuitive I agree, and it’s a 
reason that some security 
experts don’t label 
Apple’s 2FA as “real” 
2FA, but think it’s still just 
a two-step process. True 
2FA comprises two of the 
following things: some-
thing you know, some-
thing you have, or 
something you are. 
Mostly typically, that’s a 
password, a phone or token-generat-
ing device, or a fingerprint. (It can also 
be a PIN, an RFID card that’s tapped 
against a reader, or your retina.) 

The first factor is typically the 
password or PIN, which you know 
and anyone can enter from any-
where, making it globally insecure. 

The second factor for 
most consumer and 
small-business purposes 
is a code that’s gener-
ated and sent through a 
means that’s separate 
from the pathway that 
you’re using to enter the 
password. That prevents 
someone who can gain 
access to the password 
also gaining access to 
the code.

When you log in to 
Dropbox, Facebook, or 
Google, you can use 

either a Time-based One-Time 
Password (TOTP), in the form of a 
short code texted via SMS or gener-
ated via an authentication app, like 
Authy or Google Authenticator. To 
make it a true second factor, you 
shouldn’t be able to receive or 
generate the code on the same 

SO, IS THIS a 
good idea?
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device on which you’re logging in. In 
many cases, the same device is used, 
which reduces security. 

However, someone has to gain 
access to something, like your incom-
ing SMS messages or your actual 
phone, which dramatically reduces 
the odds of any arbitrary person with 
your password also gaining access to 
an account. So it’s still very useful.

Apple skews even further toward a 
second step instead of a second 
factor, which is what you’ve seen. 
Once you’ve set up a device as a 
trusted one with 2FA for your Apple 
ID, that device is always available to 
authenticate any connection that 
needs it except logging back in to 
the iCloud control panel in OS X or 
Settings → iCloud in iOS.

Thus, when you log in to a website 

in OS X that requires authentication 
from a trusted device, all your trusted 
devices—including the one on which 
you’re browsing—wind up qualifying. 
Because someone needs physical 
possession of that trusted device, 
this doesn’t eliminate every risk, but 
it does get rid of most of them. ■

MAC 911HELP DESK

Ask Mac 911
We’re always looking for problems 
to solve! Email us at mac911@
macworld.com including screen 
captures as appropriate. 

Mac 911 can’t provide direct email 
responses or answers for every 
question. For that, turn to Apple-
Care, an Apple Store Genius Bar, or 
the Apple Support Communities.


